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NOTICE 

The information contained in this manual is subject to change without notice. 

AGILENT TECHNOLOGIES MAKES NO WARRANTY OF ANY KIND WITH 
REGARD TO THIS MANUAL, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE. Agilent Technologies shall not be liable for errors contained herein or direct, 
indirect, special, incidental, or consequential damages in connection with the furnishing, 
performance, or use of the material. 

Trademarks 

Windows®,Windows® 2000 and Windows 7®, are U.S. registered trademarks of Microsoft 
Corporation in the United States and other countries. 

U.S. GOVERNMENT RESTRICTED RIGHTS 

Software and technical data rights granted to the federal government include only those rights 
customarily provided to end user customers. Agilent provides this customary commercial 
license in Software and technical data pursuant to FAR 12.211 (Technical Data) and 12.212 
(Computer Software) and, for the Department of Defense, DFARS 252.227-7015 (Technical 
Data - Commercial Items) and DFARS 227.7202-3 (Rights in Commercial Computer Software 
or Computer Software Documentation). 

© Copyright 2001-2014 Agilent Technologies. Made in USA 

This document contains proprietary information which is protected by copyright. All 
rights are reserved. No part of this document may be photocopied, reproduced, 
or translated to another language without the prior written consent of Agilent Technologies, 
Inc. 

Use of this manual and compact disk(s) or tape cartridge(s) supplied for this pack is restricted to 
this product only. Additional copies of the programs can be made for security and back-up 
purposes only. Resale of the software in its present form or with alterations is expressly 
prohibited. 
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Hardware Installation  

 

Hardware Installation 
 

 
This chapter describes installation and configuration of the N6820ES Signal Surveyor 4D.  
 
Supported Hardware 

 
The N6820ES software supports the N6841A RF Sensor. 

 

Safety Notices 
 

This product has been designed and tested in accordance with accepted industry standards, 
and has been supplied in a safe condition. The documentation contains information and 
warnings that must be followed by the user to ensure safe operation and to maintain the 
product in a safe condition. 

 

For Safety and Regulatory information, please refer to the General Specifications section 
and Safety Summary of this manual. 
 

Hardware Installation Process 
 

For N6841A RF Sensor hardware and software installation, refer to the documentation that 
came with the N6841A RF Sensor. 
 

Document Part No 

N6841A Quickstart Guide N6841-90000 

RF Sensor Software User Guide N6841-90001 

N6841A Installation Guide N6841-90002 

Instructions – LAN Connector  N6841-90003  
 
 

Basic operation consists of an N6841A RF Sensor, a system controller PC and either a 
direct Ethernet connection (between system controller and RF Sensor) or a switch/router 
connecting the sensor to the system controller. 
 

 
RF Sensors can also be networked together to provide synchronized spectral sweeps that 
are distributed in geography.  This network can also be used to compute the location 
(latitude and longitude) of signals of interest.  To network sensors together, wireless (Wifi 
or cellular) or wired can be used.  Wireless connections require that sensors have GPS lock 
for precision time synchronization.  Wired connections require the use of a IEEE1588-
compliant switch for precision time synchronization.   
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Up to four sensors’ data can be displayed by a single instance of Signal Surveyor 4D.  
However, only 1 of these sensors can be used for detection tasks/alarms.  If more sensors 
need to be used as detector sensors, you may use multiple instances of Signal Surveyor 4D, 
with one instance per sensor (up to 6 instances per system controller, where the number of 
instances depends on the power of the system controller.
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Software Installation and Configuration 
 

 
 

Software installation 
 

This chapter describes the installation and configuration of the software for the N6820ES 
Signal Surveyor 4D.

For new systems - 

User Integrated 

To install the software on a commodity laptop, follow the installation procedure described 
in Installing and Configuring the N6820ES Software (page 11). This procedure should 
handle most installation issues automatically. The minimum and recommended controller 
requirements are listed in Controller Requirements (page 8) 

 

For Upgrades  To upgrade the software from a previous version just run the setup.exe program; see Installing 
and Configuring the N6820ES Software (page 11). This procedure should handle most 
installation issues automatically. 

 
N6841A RF Sensor For software and hardware installation information, refer to the manuals that came with the 

N6841A RF Sensor. 
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Updating System Components 

 
Various files used in the previous version may need to be changed before the new version can 
be used. 

• Configuration files (such as e3238s.n6841.32bitOS.cfg and e3238s.n6841.64bitOS.cfg) 
• Resource file (the E3238s file, if used) 
• Custom library extensions 

 

 

Configuration File Update 
 

When the installation program setup.exe is run, a new configuration file is installed as 
C:\E3238s\N684x_RF_Sensor\e3238s.n6841.32bitOS.cfg and e3238s.n6841.64bitOS.cfg 
(overwriting the previous copy). Before installation, you should save off your configuration files in 
use and rename them, then compare with the new ones as appropriate to be compatible with new 
capabilities. 
 

 

 

Resource File Update 
 

The application resource file \E3238s\d.E3238s should also be compared to the resource file 
in use. 

 

 

Updating Custom Libraries 
 

It may be necessary to recompile any custom libraries which you have created. An upgrade 
note describing the details should accompany the material sent as an upgrade kit. 

New versions of libraries purchased from Agilent should be delivered to you on separate CDs 
as part of the upgrade. 

 

 

For System Recovery 
 

To recover the system from something like replacement of the system disk, first recover the 
controller operating system using the recovery disks provided with the controller and then 
perform an installation with the most recent version of the N6820ES software. See Installing 
and Configuring the N6820ES Software (page 11). 

 

Note The N6820ES software requires a valid copy of your software license file. If you do not have 
a valid license file, contact Agilent to have one regenerated and e-mailed to you. See The 
Software License File (page 19). 
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Controller Requirements 
 

The following table lists the minimum and recommended requirements for a system 
controller. 

 
 

 

CPU 
 

MINIMUM 
 

RECOMMENDED 

Processor 1.5 GHz Pentium P4 

(N6820ES libraries are optimized 

for Intel Processors) 

Dual 3 GHz Pentium 

(Load eXceed on one CPU & N6820ES 

on the other) 

Memory 2 GB 

(performance suffers with less) 

8 GB 

(More memory is always better) 

Operating 

System: 

Win 7 

 

Win 7 

 

 

Drives 
 

MINIMUM 
 

RECOMMENDED 

Hard Drive 20 GB 

(750MB required for installation of 

N6820ES SW) 

120 GB 

(750MB required for application software) 

(SCSI or Raid0 faster for snapshots) 

DVD Drive DVD drive (Needed to install 

N6820ES software and License file) 

16x DVD+RW 

(Used to install and backup software 

 

Graphics 
 

MINIMUM 
 

RECOMMENDED 

Display 17" Display 

Required to view spectral data points 

20" LCD Display 

Required to view spectral data points 

Graphic Card True 1024x1280 (on-screen 

resolution) 16 Bit True Color 

8 Mbyte On-board Video Memory 

(Required for N6820ES high speed 

color displays) 

True 1600x1600 (on-screen resolution) 32 

bit True Color 

AGP Video Card with 128 Mbyte memory 

(Required for N6820ES high speed color 

displays) 
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Communicatio 

n (I/O) 

 
MINIMUM 

 
RECOMMENDED 

Sound Card 

(Audio) 

Not required for basic operation 32 bit Stereo Audio Card (with Line in/out).  

Serial Ports Not required for basic operation 1-port (Required for Serial handoff 

receivers) 

USB 1-port (USB-1 OK) 

One port required for License Key 

4-ports (USB-2) 

One port required for License Key 

Keyboard / 

Mouse: 

Not required for Laptops. 

PS/2 or USB required for other 

controllers (If USB make sure you 

have enough USB ports) 

Not required for Laptops. 

PS/2 or USB required for other controllers 

(If USB make sure you have enough USB 

ports) 

Networking Not required for basic operation. 

Required for Multiple System 

Synchronization (MSS) 

(Use: Connection to other systems on 

the network.) 

100/1000 Mbit/s Network Interface 

card(NIC). Required for Multiple System 

Synchronization (MSS) 

(Use: Connection to other systems on the 

network.) 
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Software 
 

MINIMUM 
 

RECOMMENDED 

Anti-Virus 

Software 

Not required for basic operation 

of E3283S system 

Symantec Anti-Viruses software 

Microsoft Office 

Suite 

(Word, Excel & 

Power Point) 

Not required for basic operation 

of E3283S system 

(Use: Export of  

databases to a spreadsheet for 

manipulation of data and/or 

report creation 

Microsoft Office Word & Excel (Win2K) 

(Use: Export of databases to a 

spreadsheet for manipulation of data and/or 

report creation 

Microsoft Visual 

Studio 

Not required for basic operation Visual Studio .net 

(Use: User Programming (ASD) and Signals 

Development) 
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Installing and Configuring the N6820ES Software 
 

This section describes the procedures used to install the software and associated libraries for the 
Windows® 7 operating system on a laptop controller. 

 

Note                       None of the installation procedures given here need be performed on systems delivered direct from 
the factory. All software on a new system is installed, configured, and tested before it is 
shipped. 

The steps to complete these actions are described in the following procedures. 

This section describes the installation and configuration process onto a laptop running the 
Windows® 7 Professional operating system. The procedures are similar on a system running 
Windows 2000® Server. 

Note The installation will check for necessary IO libraries. If they do not exist, you will be prompted 
to install the Agilent IO Libraries which will require you to repeat the installation a second 
time. 

Note                          Be sure that the application is installed before installing the license software. Also, if your 
software license uses a USB key, the USB key must be disconnected from the computer until 
after the N6820ES application software has been installed. 
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Configure the Operating System 

 

The first task is to set up the operating system. 
 

1. Click Start - Control Panel - Display. 
 

2. In the Display Properties dialog box, click the Settings tab. 
 

3. Set the Screen resolution slider to a setting equal to or greater than 1024 by 768 pixels. 
Note that some windows created by the program may require a larger screen area than 
1024 by 768 pixels. If you encounter this problem, set the slider to a larger screen area. 

 

4. Set the Color quality selection to be equal to or greater than 256 colors. 
 

5. Click OK to close the Display Properties dialog box. You can also close the Control 
Panel window. 

 

6. Double-click the desktop icon My Computer and then click Tools, Folder Options... 
 

7. Click the View tab 
 

8. Under Advanced settings, enable Show hidden files and folders. 
 

9. Make sure that Hide file extensions for known file types is disabled. 
 

10. Click OK to close the Folder options dialog box. 
 

 

Setup the Filesystem 
 

This procedure creates the folders for the N6820ES  software. Agilent recommends copying an 
image of the N6820ES DVD to the computer’s C: drive. Placing the image on the C: drive 
allows the software to be re-installed without the distribution DVD. 

 

1. On the C: disk, create the folder C:\Images\N6820ES\1.0 

2. Copy the contents of the E3238S DVD to the folder: C:\Images\N6820ES\1.0 

3. If you are installing any options from a separate CD or DVD, create the folder: 

C:\Images\N6820ES\1.0\Option 

Where Option is the name of the software of the option you will install. 
 

4. Copy any option CD or DVD to the appropriate folders. 
 

Installing the options is described in Installing Software Options (page 16) 

 
 

Alternatively, you can download the latest software image from the Agilent N6820ES web page.



13 

Software Installation and Configuration  

 

 
 

Install the N6820ES Program 
 

Note                        Be sure that the N6820ES application is installed before installing the license software. Also, if 
your software license uses a USB key, the USB key must be disconnected from the computer 
until after the application software has been installed. 

 
1. Insert the Agilent N6820ES application DVD in the drive. It should auto-start and 

display an opening screen. You may also choose to run the installation from 
C:\Images\N6820ES\1.0\Winnt\Setup.exe 

 

2. From the Installation screen, click “Install N6820ES now,” read the next screen 
and click Next. 

 
 

3. If no IO Libraries are installed, you will be prompted to install the Agilent IO Libraries. 
You should install the Agilent IO Libraries.  (The newest version of the installer will not ask 
this question). 
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4. Once you have selected to install the Agilent IO Libraries, you will be given a notice 
that you must Restart the installation of the N6820ES  software. 

 

 

 
5. When the Agilent IO Libraries installation is complete, clear the "Yes, I want to 
connect to my instrument. Launch Agilent Connection Expert" 
selection. Click Finish and the N6820ES installation should resume. If it doesn’t, re- 
start the installation following the instructions in step 1. 

 

6. If the Exceed X Server is not present on your system, you will be prompted to install 
the Exceed X server.1 

 

 
 

7. Click "Yes" to install the Exceed X Server Software 
 

8. Once the Exceed installation is complete, the installation should continue 
automatically. If it doesn’t, re-start the installation following the instructions in step 1. 

 

 
 
 
 
 

1If the Firewall is enabled, the Exceed installation may generate a security alert. 
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9. If you are installing the N6820ES software for the first time on a PC, you may encounter 
a spurious error message generated by the FLEXid dogle driver installer, directing you 
to reboot your system at that point in the install procedure. . 

 

 
 

Click OK and proceed with the installation. You will reboot the system when all of the 
software has been installed. 

10. Click “Finish” to complete the E3238S installation 
 

11. Click "Finish" to complete the installation. You will be prompted to re-start. 
 

12. When the installation is completed, remove the E3238S installation DVD. 
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Installing Software Options 
 

If your system has one or more software options, use the following procedure to install and 
configure them: 

 

1. If you have not yet done so, copy the library DVD to the system disk. 
 

We recommend copying the contents of the E3238S DVD onto the system disk to: 
C:\Images\N6820ES\E3.4\Option 

Where Option is the name of the software of the option you will install. 
 

2. Run the installation program by executing the  setup.exe program in the directory: 
\images\N6820ES\E3.4\Option\ 

 

3. Modify the e3238s.cfg file to enable the selected libraries: 
 

The sections of the e3238s.cfg file that control the libraries are found at the file’s end. 
Details are given in a readme.txt file installed in each library’s install directory (e.g., 
narrow band recorder, option NBR, is installed in \E3238s\NBR) 

To enable a library, 

a. Using a text editor, open the configuration file  \E3238s\e3238s.cfg. 

b. Scroll to the bottom of the file 

c. Remove the exclamation points preceding the appropriate command lines controlling 
the desired library. 

d. Enter the appropriate arguments to the setup commands. 
 

Follow the instructions given in the ReadMe file to properly configure the option settings 
(e.g., maxChannels, loadFactor, etc.) 

 

4. The ReadMe file may also include information describing application settings that must 
be used to ensure the proper operation of the option. See the following example. 

 

In the following example the Direction Finding library and the Modulation Recognition 
library are enabled. 

!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 
!! 
! Direction Finding ! 
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 
!! 
df1.enabled: True 

df1.hostLib: c:/e3238s/DF1/DF1.dll 
!df1.args: 
!df1.alias: 
!df1.latitude: 
!df1.longitude: 
!df1.declination: 

!df1.heading: 

 
 

!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 

!! 
! Modulation Recognition ! 
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 
!! 
modRec1.enabled: True 
modRec1.hostLib: c:/e3238s/MR1/MR1.dll 
!modRec1.args: 

!modRec1.alias: 
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Software Licensing 
 

Trial License 

This section documents how to obtain and install a Trial license for your N6820ES software. 
The Trial License provides fully licensed N6820ES software for a temporary 30 day trial 
period. This gives you time to purchase, redeem, and install a permanent license while 
continuing to use the N6820ES software. When the Trial period expires, the N6820ES 
software license either reverts back to a Demo license or to any prior installed valid license. 

 

Note                           You will only be granted one Trial license per license Host ID.  Once the trial license is 
expired, you cannot get another. 

 

Obtaining a Trial License 

To enable a Trial license, you must obtain your PC's Host ID, then go to Agilent's online 
License Manager and redeem the trial license. 

 

Finding Your PC's Host ID 

To obtain the License Notifier Host ID for the PC on which you have installed Agilent 
N6820ES software, follow these steps: 

1. Open the Agilent License Notifier dialog box 

2. Right-click the Agilent License Notifier program icon  in the Windows desktop 
Toolbar (if the program icon  is hidden, click the "Show hidden icons" button on the 
right side of the toolbar.) 

3. Select the About Agilent License Notifer item. 

4. Use the Copy button to copy the PC Host ID into the Windows clipboard.  

 

 
 

Note                           On desktop or laptop PCs, the default model number is PCSERNO.. 

 

Getting the Trial License 

1. Go to the Agilent N6820ES website at http://www.agilent.com/find/N6820ES, select the 
Software Trials & Licenses tab, then follow the instructions to obtain a Trial license. 

a. You must provide contact information. 

b. The requested Host ID is available from the Agilent License Manager as 
described above. If you are accessing the website from the same PC that the 
N6820ES software is installed, you can simply copy and paste the Host ID into 
the website form. 

http://www.agilent.com/find/N6820ES
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c. You will only be granted one Trial license per license Host ID. 

2. After you finish using the Agilent website, check your email from Agilent containing 
your license file, then proceed to "Installing a License" below to complete the 
installation. 

 

Installing a License 

When you receive the Agilent email containing your license file, follow these steps to install 
it: 

1. Place the license file either on a network-connected drive or on a drive that is directly 
connected to the PC. 

2. Start the Agilent License Manager by clicking Utilities > Licenses > Status > Agilent 
License Manager or double clicking on the Agilent License Notifier icon  in your 
Windows notification area.  

3. In Agilent License Manager, click File > Install. 

4. An Install License File(s) window appears. In this window, browse to the location where 
you saved the license file. Select the license file, and then click the Open button. 

 

The Agilent License Manager installs the license (from the selected license file)and then 
displays it in the Tree View as an installed license under localhost (your PC). Note that the 
install operation takes up to 40 seconds to complete.  

For details on other ways to install licenses, see Installing Licenses in the Agilent License 
Manager Help (click Help > Agilent License Manager Help from within the Agilent License 
Manager utility or click Start > (All) Programs > Agilent License Manager > Agilent 
License Manager Help). 

 

Transportable License 

This section describes the steps to obtain and install a Transportable license. The 
Transportable license enables the N6820ES software and options that you have purchased. 
The license must be installed on the same PC that runs the N6820ES software. However, the 
license can be transferred from one PC to another PC. Transferring the license requires the 
Agilent License Manager to communicate with the Agilent Software Manager website. 

To obtain and install a Transportable license: 

1. Purchase an N6820ES Software Transportable License. 

2. Receive a Software License Entitlement Certificate. 

3. After purchasing a Transportable License, you will receive a Software License 
Entitlement Certificate. 

4. Redeem the License. 

5. As described in "Redeeming a Transportable License" below, the Software License 
Entitlement Certificate provides instructions to redeem your license. 

6. Install the License file. 

7. As described in "Installing a Transportable License" on the next page, after providing the 
required information, the Agilent Software Manager website will e-mail a License file 
(.lic) to you. Install the license file on the same PC that runs the N6820ES software. 

8. Activate the License. 

9. After installing the license, you need to restart the N6820ES software to activate the 
license.  
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Redeeming a Transportable License 

After purchasing a Transportable License, you will receive a Software License Entitlement 
Certificate. You will need information from the certificate to redeem and activate a license. 
To redeem a transportable license, follow these steps:  

1. Collect the Software License Entitlement Certificates for all N6820ES software options 
that you have purchased. The Software License Entitlement Certificates are emailed to 
you. 

2. Obtain the Host identification information (Host ID). Use the Agilent License Notifier 
utility or Agilent License Manager to obtain the Host ID. 

3. Open the About Agilent License Notifier utility, right click the “Agilent License 
Notifier” icon  in the Windows desktop notification area (lower right side of the 
Windows Task bar) and select About Agilent License Notifier. 

4. Click the Copy button to the right of the Host ID box. The Host ID information is copied 
into the Windows clipboard. 

5. Redeem your licenses and obtain the license files. Follow the instructions included on 
the Software License Entitlement Certificate to redeem your licenses and obtain the 
license files. Go to the Agilent Software Manager website: 
http://www.agilent.com/find/softwaremanager 

 First time access will require you to register 

IMPORTANT Remember your user password. The password is required for future access to 
manage your licenses 

 You will need the Agilent Order Number and Agilent Certificate Number located 

on the top of your Software License Entitlement Certificate. 

6. Install License File(s): Check your e-mail for the license files(s) and then install them on 
the PC – go to “Installing a Transportable License” below. 

 

Installing a Transportable License 

Installing the license file is necessary to license the N6820ES software. After completing 
"Redeeming a Transportable License" on the previous page, you will receive an Agilent email 
containing your license file for the redeemed Entitlement Certificates. Follow these steps to 
install the license files on the PC: 

1. Copy the email attachment ".lic" to a folder on your PC, connected hard drive, or USB 
storage device. 

2. Start the Agilent License Manager: click Utilities > Licenses > Status > Agilent License 
Manager or double clicking the Agilent License Notifier icon . 

3. In Agilent License Manager, click File > Install, browse to the location where you saved 
the ".lic" license file, select the license file, and click the Open button. Or, you can drag-
and-drop the license file onto the Agilent License Manager License Features window. 

 
The Agilent License Manager installs the license and lists it in the Agilent License Manager 
window, localhost node. 

 

Note                           The install operation can take up to 40 seconds to complete. 

 
 
 
 
 

http://www.agilent.com/find/softwaremanager
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For details on other ways to install licenses, see Installing Licenses in the Agilent License 

Manager Help (click Help > Agilent License Manager Help from within the Agilent License 

Manager utility or click Start > (All) Programs > Agilent License Manager > Agilent License 

Manager Help). 

 

Transporting a Transportable License 
The Transportable license is a license that can be moved from one PC to different PC. This 

allows you to use one license to run the N6820ES Software on different PC's. However, only 

one PC at a time can use a single license. The transportation of a license requires an Internet 

browser and a connection to the Agilent Software Manager website. 

 

Note                           A license transport operation may take up to 90 seconds to complete. 

 

Choose one of the following procedures based on your network configuration to transport a 

Transportable license: 

 Both Source and Target PCs Connected to a LAN 

 Target PC Not Connected to a LAN 

 Source PC Not Connected to a LAN 

 Both Source PC and Target PC Not Connected to a LAN 

Both Source and Target PCs Connected to a LAN 
When both the source PC and the target PC are connected to a LAN, you can easily transport a 

Transportable license in one of the two following ways. (Note that these methods assume that 

both the source PC and target PC are connected (use File > Connect) in the Agilent License 

Manager and visible in the Tree View.)  

 In the Agilent License Manager's Tree View, select a license or product (to transport 

all licenses for the product) on the source PC and drag it to the target PC’s IP 

address/hostname node. The licenses are automatically transported from the source 

PC to the target PC. 

 

Or: 

 In the Tree View, select a license or product (to transport all licenses for the product), 

then click File > Transport. This opens the Transport one or more licenses dialog box. 

Select the target host name from the drop down box and click the Transport button. 

The licenses are automatically transported from the source PC to the target PC. 

Target PC Not Connected to a LAN 
When the target PC is not connected to a LAN, the transport operation requires additional steps 

than if all PCs have network connectivity. To transport a license to a non-connected PC you 

must: 

 Obtain the Host identification of the destination PC. 

 Use the Agilent License Manager to remove the license from the source PC and 

provide a confirmation code of the removal. 

 Connect to the Agilent Software Manager website and provide the destination PC's 

Host identification and the license removal confirmation code. 

 Save the new license file. 

 Install the new license file on the destination PC. 
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Use the following procedure to transport a license when the source PC has an Internet 

connection, but has no connection with the destination PC. 

1. On the source PC, click Start > (All) Programs > Agilent License Manager > Agilent 

License Manager. 

2. In the Tree View, select a license or product (to transport all licenses for the product). 

Click File > Transport. This opens the Transport one or more licenses dialog box. 

3. Since the destination PC is off line, keep the Destination Host as <offline>. Click the 

Transport button. You will be asked to verify the transport. Click the Yes button. 

4. This opens a Transportation Confirmation screen, which verifies that the license was 

deleted from the localhost and displays a confirmation code. This confirmation screen 

also specifies a path and the URL file so that you can re-host the license at a later 

time. Click the Explore button to view the file, otherwise, click the OK button to 

return to the main display. 

5. From the Agilent License Manager, click Tools > Explore Transport Confirmation 

URLs. This opens the folder where the Transport Confirmation files have been saved. 

6. Double-click the .url Transport Confirmation file for the license you want to re-host. 

This opens the Agilent Software Manager website, which enables you to acquire a 

transported license that is node-locked to the target PC. 

7. Find the Host identification on the PC on which you are installing the N6820ES 

software license. The license Host identification (Host ID) is used in the Agilent 

Software Manager website to redeem your license. 

a. Open the About Agilent License Notifier utility, right click the "Agilent License 

Notifier icon  in the Windows desktop notification area (lower right side of 

the Windows Task bar) and select About Agilent License Notifier. 

b. Click the Copy button to the right of the Host ID box. The Host ID information 

is copied into the Windows clipboard. 

8. On the Agilent Software Manager website, enter the target PC's Host identification 

(Host ID), and then click the Submit button.  

9. The Agilent Software Manager website displays a link for the license. On the license 

link, right-click the link and select Save Target As.  

10. On the source PC, save the ".lic" license file. 

11. On the source PC, connect an external, portable mass storage device—such as a USB 

Flash Drive, an external hard drive, or a writable CD/DVD. 

12. On the source PC, copy the license file to the portable mass storage device. 

13. Disconnect the portable mass storage device from the source PC and connect it to the 

target PC. 

14. On the target PC, click Start > (All) Programs > Agilent License Manager > Agilent 

License Manager. 

15. On the target PC, open Windows Explorer, locate the .lic license file saved on the 

connected portable storage device, and then drag the license file into the Tree view. 

Source PC Not Connected to a LAN 
If the source PC is not connected to a LAN, the transport operation requires additional steps 

than if all PCs have network connectivity. To transport a license from a non-connected PC you 
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must: 

 Use the Agilent license Manager to remove the license from the source PC and 

provide a.url file to confirm the license removal. 

 Move the .url file to the destination PC. 

 On the destination PC, open the .url file to connect to the Agilent Software Manager 

website and  provide the destination PC's Host identification. 

 Save the new license file. 

 Install the new license file on the destination PC. 

Follow this procedure to transport a license when the source PC is not connected to a LAN. 

(Note that this procedure assumes that the destination PC has an Internet connection.) 

1. On the source PC, click Start > (All) Programs > Agilent License Manager > Agilent 

License Manager. 

2. In the Tree View, select a license or product (to transport all licenses for the product). 

Click File > Transport. This open the Transport one or more licenses dialog box. 

3. Since the Target PC is off line, keep the Destination Host as <offline>. Click the 

Transport button. You will be asked to verify the transport. Click the Yes button. 

4. This opens a Transportation Confirmation screen indicating that the license was 

deleted from the localhost and shows the confirmation code. This confirmation 

screen also specifies a path and the.url file so that you can re-host the license. Click 

the Explore button to view the file, otherwise, click the OK button to return to the 

Agilent License Manager main display. 

5. On the source PC, connect an external, portable mass storage device—such as: a USB 

Flash Drive, an external hard drive, or a writable CD/DVD. 

6. On the source PC, copy the .url file to the portable mass storage device. 

7. Disconnect the portable mass storage device from the source PC and connect it to the 

destination PC. 

8. On the destination PC, locate the .url file on the portable mass storage device and 

double-click it. 

9. On the destination PC, the .url file opens a browser window that is connected to the 

Agilent Software Manager website. Note that the fields are automatically filled in 

with the license contents. 

10. On the Agilent Software Manager website, type the target PC’s Host identification 

(Host ID) and then click the Submit button. 

11. The Agilent Software Manager website displays a link for the license. On the license 

link, right-click the link and select Save Target As. 

12. On the destination PC, save the license file. 

13. On the destination PC, click Start > (All) Programs > Agilent License Manager > 

Agilent License Manager. 

14. On the destination PC, open Windows Explorer, locate the license file, and then drag 

the license file into the Tree View. 

Both Source and Target PCs Not Connected to a LAN 
If neither the source PC nor the target PC are connected to a LAN, the transport operation 
requires additional steps than if the PCs have network connectivity. To transport a license from 

a non-connected PC to a non-connected PC you must: 
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 Use the Agilent license Manager to remove the license from the source PC and 

provide a .url file to confirm the license removal. 

 Move the .url file to PC that has Internet connectivity. 

 On the Internet-connected PC, open the .url file to connect to the Agilent Software 

Manager website and provide the destination PC's Host identification. 

 Save the new license file. 

 Move the license file to the destination PC. 

 Install the new license file on the destination PC. 

Follow this procedure to transport a license when both the source PC and the target PC are not 

connected to a LAN. 

1. On the source PC, click Start > (All) Programs > Agilent License Manager > Agilent 

License Manager. 

2. In the Tree View, select a license or product (to transport all licenses for the 

product). Click File > Transport. This open the Transport one or more licenses 

dialog box. 

3. Since the target PC is off line, keep the Destination Host as <offline>. Click the 

Transport button. You will be asked to verify the transport. Click the Yes button. 

4. This opens a Transportation Confirmation screen indicating that the license was 

deleted from the localhost and shows the confirmation code. This confirmation 

screen also specifies a path and the .url file so that you can re-host the license. Click 

the Explore button to view the file, otherwise, click the OK button to return to the 

Agilent License Manager main display. 

5. On the source PC, connect an external, portable mass storage device—such as: a 

USB Flash Drive, an external hard drive, or a writable CD/DVD. 

6. On the source PC, copy the .url file, to the portable mass storage device. 

7. Disconnect the portable mass storage device from the source PC and connect it to a 

PC with an internet connection. 

8. Using Windows Explorer on the internet-connected PC, locate the .url file on the 

portable mass storage device and double-click it. 

9. Clicking on the .url file opens a browser window that is connected to the Agilent 

Software Manager website. Note that the fields are automatically filled in with the 

license contents. 

10. On the Agilent Software Manager website, type the target PC’s Host identification 

(Host ID) and then click the Submit button. 

11. The Agilent Software Manager website displays a link for the (re-issued) license. On 

the license link, right-click the link and select Save Target As. 

12. Save the license file to a location on the portable mass storage device. 

13. Disconnect the portable mass storage device from the internet-connected PC and 

connect it to the target PC. 

14. On the target PC, click Start > (All) Programs > Agilent License Manager > Agilent 

License Manager. 
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15. On the target PC, open Windows Explorer, locate the .lic license file saved on the 

connected portable storage device, and then drag the license file into the Tree 

view. 

Firewall Configuration and Setup 
The N6820ES installer will automatically configure the following firewalls to allow correct 

operation of Agilent Licensing: 

- Microsoft Windows Firewall 

- ZoneAlarm Firewall 

- Comodo Firewall 

If your PC has another firewall installed and enabled, your system administrator may need to 

allow certain executables and/or a limited range of port numbers to go through the firewall.  

Always allow the following executables from Agilent to communicate through the firewall: the 

AgilentLicenseService, Agilent License Manager and AgilentLicenseNotifier. In addition, you 

must explicitly open TCP ports 8000, 8001, and 8020. 

 

Pre-May 2014 License Installation 
 

Notes Be sure that the N6820ES application is installed before installing the license software. Also, 
if your software license uses a USB key, the USB key must be disconnected from the computer 
until after the application software has been installed. 

 
The first time the USB Key is connected to a USB port, Windows runs the New Hardware 
Found wizard. This wizard associates the USB Key with the correct software drivers. 

 

 
From a License CD If you have received a license file CD, then install the E3238S software license file as 

follows: 
 

1. Place the E3238S license CD into the system’s CD or DVD drive. 
 

2. When the automatic installation procedure displays its window, click the button labeled 
“Next.” 

 

When the license installation is complete, remove the license CD and store it in a safe place. 
 

From a File If you have received a license file in some other manner, such as by E-mail, and the software 
is installed on the computer, install the license file as follows: 

 

1. Copy the license file to the c:\E3238s\licenses\new directory. 
 

2. Run the license installer program that was installed with the N6820ES program. 
Click Start - Programs - Agilent N6820ES - Tools - License Installer 

 

When finished, save a copy of the original license file in a safe place. Common 

problems and their solutions are listed on the next page. 
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Dealing with License Problems 
 

If the software is unable to validate its license, an error message is displayed. If you experience 
license problems, check for the following common causes. 

 

• Is the license file at the location expected by the software? 
Check for the presence of the environment variables 

AGILSURV_LICENSE_FILE or LM_LICENSE_FILE. 
These are used to specify the directory that contains the license file, (typically 
C:\E3238s\license\). 

 

There are two ways to check the environment variables: 

• Open a command window and type “set” (and Enter) at the prompt. 
• Right-click My Computer (icon), click Properties , Advanced (tab), Environment 

Variables (button) 
 

Operational license file names end with the .lic extension. 

• Is the license current? 
Check that the license name does not end in -temp.lic. If it does, it is a temporary license 
and may have expired. To see if the license has expired, open the file with a text editor; 
the expiration date is shown on the INCREMENT line. See the note below. 

 

• Is the license valid for the hardware? 

• If the license is for a USB Key, make sure that you have the correct USB Key connected 
securely in the computer’s USB port. Compare the serial number listed in the license file 
with the number on the USB Key. 

• If the license is keyed to a specific computer, make sure that the correct computer is 
being used. To do this: 

1. Run the HostID utility (Start - Programs - Agilent N6820ES  - HostID). This displays 
the computer’s host ID. (pairs of numbers separated by colons) 

2. Open the license file in a text editor. The same number sequence should follow 
HOSTID= 

 

Note The application is enabled only when the license file and hostID is as provided by Agilent. If 
changed, the hostID string can be changed back to the proper value and continue to function 
properly. 

 
• Is the license valid for the current version of the software? 

Licenses for earlier versions of the software may not be valid for later releases. 
See the note below. 

 

• Is the license valid for your software options? 
Make sure that the license directory contains a valid license. It is acceptable to have more 
than one license file in the license directory. This is useful for multiple systems and 
multiple USB Keys. See the following note. 

 

Note Old license files can cause problems. You should rename (change the extension or add 
another extension after .lic) or delete all old license files. 
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The Software License File (Pre-May 2014) 
 

The N6820ES software requires a license file to run. This section describes where this file is 
located, what it is named, and how to resolve some common license problems. 

 
For new, Factory Integrated systems 

 

If your system was integrated at the factory, your license file is correctly configured for using 
your system. Place the License File CD in a secure location. 

 
For Other Users 

 

This license file is provided directly by Agilent; it is unique for each installation. The license file 
is installed using the License File CD which is distributed by Agilent for the software 
installation procedure. The license file is valid only for the software configuration that you have 
purchased. The license file cannot be edited and remain valid. 

 

If any parameter of the license must be changed (for example, addition of new libraries, 
expiration date, version number, Ethernet address, or USB Key hostID) the license file must 
be re-generated by Agilent. The new license must then be re-installed. 

 

The software runs only on a controller or PC upon which its license is valid. The software 
checks that it is running on a proper controller by one of two processes: 

 

• Verifying the presence of a USB Key in a USB port. This is the most flexible method. 
This option allows the software to be installed and run on various PCs by moving the key 
to the new PC. 

 

• Verifying the computer’s hostID. This option locks the software to one host computer. 
This is the simplest method when the software can be locked to a single computer. 

 

Note The software runs only when the license file is properly installed and the corresponding 
hostID is present. A computer-keyed license locks the software to a specific computer. A 
USB-keyed license locks the software to a specific USB Key. 

 
The software and license file for the USB Key may be installed on several different 
computers. If this is the case, then to use any specific computer, you need only connect one 
of the valid USB Keys to that computer’s USB port. 

 
License File Location 

 

During the installation of the software, the installation process creates an environment 
variable named AGILSURV_LICENSE_FILE; this variable specifies the pathname of the 
license file. By default this location value is: 

\E3238s\licenses\ 

If the environment variable AGILSURV_LICENSE_FILE does not exist, or if the software 
cannot find the license file at the pathname specified by the variable, the software checks for 
the presence of a second variable, LM_LICENSE_FILE. Note that this second environment 
variable is not automatically created and has no default value. 

 

The value of either variable can be changed to modify the location and name of the license 
file, but use care to ensure that the contents of one of the variables match the pathname of 
the valid license file. 
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If the software is, at startup, unable to validate its license because the license file is not in its 
expected location or the license does not match the expected controller hardware, the software 
displays an error message. For more information on resolving license problems, see Licensing 
Validation Problems. 

 
Temporary Licenses 

 

If a copy of the software is used for training or demonstration purposes, it may be provided 
with a temporary license. Temporary licenses can be identified by the suffix - temp.lic in their 
names. When a long-term license is installed, the temporary license should be deleted or re-
named with a filename extension other than .lic. This action prevents the temporary license 
from interfering with the software recognizing its correct license. 

 

If a temporary license expires while the software is running, the software provides a 10-
minute grace period to save mission data and setup files before shutting down. 
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USB-Keyed Licenses 
 

A USB-keyed license can be installed on any PC that runs the software (E.01.00 version or 
higher) and has a free USB port. This license allows the software to start if the corresponding 
key is connected to one of the PC’s USB ports and the value of the license file matches the USB 
Key hostID. If the key is not present when the software starts, the software displays an error 
message. 

USB Key-based license files have names like the following example: 

N6820E-20JW1234-FLEXID=9-7e1234e6-SWL-14Apr2006.lic 
N6820E-20JW1234-FLEXID=9-7e1234e6-SWL-14Apr2006-temp.lic 

 

Where 20JW1234 is the license number, 9-7e1234e6 is the FLEXid (USB Key’s hostID), 
and the date shown is the creation date. 

The first time the USB Key is inserted in a USB port, Microsoft Windows runs the ’New 
Hardware Found’ wizard. This wizard associates the hardware key with the correct software 
drivers. After this first insertion, Windows will run the New Hardware Found wizard only 
when the key is installed in a different USB port. 

If the key is removed while the software is running, within a few minutes the software displays 
an error message. This message notifies the user that the license that allows the software to 
run is no longer valid. When this message is displayed, the software provides a 10 minute 
grace period to save mission data and setup files before shutting down. Good practice 
recommends immediately saving your mission data and setup files, then re- attaching the USB 
Key and clicking the dialog box’s “OK” button. 

 
Computer-Keyed Licenses 

 

The license file is installed on the PC that has the corresponding hostID. This value is 
composed of information derived from the computer. 

If the hostID does not match the computer when the software starts, the software displays an error 
message. 

The GUI interface will halt until the component is returned and the user clicks the dialog 
box’s “OK” button. 

License files provided by Agilent have names like the following example: 

N6820E-20JW1234-11ab56789a12-SWL-14Apr2006.lic 
N6820E-20JW1234-11ab56789a12-SWL-14Apr2006-temp.lic 

 

Where 20JW1234 is the license number, 11ab56789a12 is the hostID, and the date shown 
is the creation date. 
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In Case of Failure 
 

This recommendation assumes that you have a failure recovery plan for the entire system that 
includes spares for vital components, especially the computer. To recover from a computer 
failure, a backup computer should be available that has the software installed and is properly 
configured. The following discussion describes how to activate the software license on the 
backup system. 

 
Computer Failure 

 

If the computer has failed and a backup computer is available: 
 

• On a USB-keyed system: move the USB Key to the backup system and continue 
operation. 

 

• On a computer-keyed system: (see below) 

 
License hostID Device Failure 

 

This section describes how to recover from the loss of a functional license due to a hardware 
failure in your hostID device. This is indicated by an error message stating that the licensing 
system could not validate the license. 

Each of the two licensing methods has its associated failure mechanism. 
 

• USB-key based licensing relies on the presence of the USB Key. The failure or loss of the 
original USB Key disables the licensing on this kind of system. 

 

• Computer-key based licensing relies on a computer identification which is derived from its 
hardware components. The failure or removal of the components used to characterize it 
will disable the licensing on such a system. 

 

USB-key 

Recovery 

If the USB Key fails, notify the license administration team. See Licensing Support. 
Arrangements will be made to send a replacement license file and USB key. You will be asked 
to return the failed USB key to Agilent. 

To continue operation until the replacements arrive, you have two choices: 
 

1. The license administration team can E-mail you a temporary computer-keyed license file 
to enable a particular system to run. 

 

2. Install the Backup Key. See The Backup Key. 
 

Computer-key 

Recovery 

Notify the license administration team of the failure. See Licensing Support. Arrangements 
will be made to send a replacement computer-keyed license file. (This can be done via E-
mail.) You will be asked to provide documentation of the computer’s failure. 

To continue operation until the replacement file arrives you can install the Backup Key. See 
The Backup Key. 



30 

Software Installation and Configuration  

 

 
 

The Backup Key 
 

To assure a quick, fail-safe recovery mechanism for the software licensing, a Backup Key is 
provided. This special USB Key is shipped in a package marked as a “single-use emergency 
backup key.” 

The Backup Key will enable operation of the software for a limited time1 whether the original 
key mechanism was USB-key based or computer-key based. This provides temporary license 
recovery for situations where you are unable to contact the license administration team at the 
time of the failure and when you need your system to be back up and running in a very short 
period of time. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1The length of time that the backup key will activate the program is specified on a notice that 

is delivered with the key. 



31 

Software Installation and Configuration  

 

 
 

Licensing Validation Problems 
 

If you are experiencing problems with your license, check for the following common causes. 

Is the license file at the location expected by the software? 
Check for the presence of the environment variables AGILSURV_LICENSE_FILE and LM_ 
LICENSE_FILE. If either of them are present, make sure that they describe the path that 

contains the license file, (typically \E3238s\licenses). Make sure that directory contains 
a valid license and that the license file name ends in ".lic". 

Is the license current? 
If the license name ends in -temp.lic, it may have expired. To check whether a temporary 
license has expired, open the license file using a text editor and find the first date that appears 
in the file. This is the license’s expiration date. 

Is the license valid for the hardware? 
On computer-keyed systems, make sure that the license file's hostID (shown both in the file 
name and in the file text) matches one of the hostID values found in the file 
C:\temp\e3238sHostID.text file written by the HostID utility program. To run this utility 
program, click Start - Programs - Agilent N6820ES - HostID 

 

When the license is locked to a USB Key, make sure that you have the correct key plugged 
securely into the laptop’s USB port. 

Is the license valid for the current version of the software? 
Licenses for earlier versions of the software may not be valid for later releases. 

 

 

Licensing Support 
 

To contact Agilent regarding licensing needs: 

Agilent N6820ES Software Licensing Administration: 
 

Telephone: (425) 356-6261 

E-mail: eveswl@agilent.com 

Fax: (425) 356-6260 
 

Hours: 8 AM to 5 PM Pacific Time, Monday-Friday 
except Agilent holidays. 

Temporary and replacement files require information created with the HostID utility. Start - 
Programs - Agilent N6820ES - HostID. This creates the file 
C:\temp\e3238sHostID.txt which can be emailed to Agilent. 

mailto:eveswl@agilent.com
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Modifying the Hardware Configuration File 
 

The application obtains hardware configuration information from the file e3238s.cfg, 
which is located in the N684X_RF_Sensor directory (e.g., 
C:\E3238s\N684X_RF_Sensor). A default hardware configuration file 
(d.e3238s.cfg) is also installed in this directory. If an e3238s.cfg file is not found 
when the N6820ES software is installed, the default configuration file is automatically 
copied to e3238s.cfg. 

 

For more information about hardware configuration and the definitions used in the 
e3238s.cfg file see Hardware Installation on page 4 1and Hardware Configuration 
Reference on page 40. 

 
Upgrades When upgrading software, new features may not work properly until the new configuration 

information is specified in the “old” e3238s.cfg file. If you are installing the upgrade over 
the previous version, (i.e., the e3238s.cfg configuration file already exists in the E3238S 
directory) the configuration file is not overwritten. This avoids losing the information in the 
existing file. 

To setup the new configuration 

1. Rename the existing e3238s.cfg if you wish to save it 

2. Copy the file d.e3238s.cfg to e3238s.cfg 

3. Edit the new e3238s.cfg file so that it accurately defines the hardware configuration 

                                                           
1  
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Configuring X Window Application Resources 
 

The X Windows system uses a resource file to allow users to control various application 
variables. Those created specifically for the N6820ES are described in the section called 
“Application Resources” on page 75. 

 

A default resource file for the program (d.E3238s) is provided in the c:\e3238s directory. 
To modify E3238S resources, copy the d.E3238s file to E3238s and edit the file as 
appropriate. 

 

To customize the resources for a specific user, place the modified E3238s file in the user's 
Profile directory (C:\WINNT\Profiles\<user_name>), or in the user's HOME 

directory as defined in the Windows® User Manager. 
 

The resource file in the N6820ES directory (e.g., C:\E3238s) applies to all users that do 
not have a resource file in their Profile or HOME directories. 

When the application is started, the window manager searches a number of places until it 
finds the E3238s resource file. It uses the first one it finds. The resource file search order is 
as follows: 

1. User Profile directory 
2. User HOME directory 

3. N6820ES directory (as defined during installation) 

4. Standard Exceed locations (XUSERFILESEARCHPATH env var & others) 

See the Exceed X Development Kit User's Guide for more information. 
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Miscellaneous N6820ES Configurations 
 

 

Secure Display Setup 
 

The application contains a security feature that blanks the N6820ES window when you 
select Utilities, Secure Display (or press Ctrl-S). 

 

• By default, this feature is enabled. It may be disabled by editing the e3238s.cfg file and 
commenting out the line disableAccess: Secure Display 

 

• To restore the normal application display, enter the current user's password. 
 

• To determine the current user's name, press Ctrl-Alt-Del. 
 

Using a blank 

password 

Windows XP security policy can interfere with the use of no password in locations other than 
the main console logon. To resolve this issue, disable it as follows: 

Control Panel... 
Administrative Tools... 
Local Security Policy... 

Local Policies... 
Security Options... 

If the entry listed below is listed as ’Enabled’, double-click it and select ’Disabled’: 

Accounts: Limit local account use of blank passwords to console logon only: 

When this is disabled, user accounts that have no password can recover the secured display 
without entering a password. 

 

 

Access Control Security 
 

The application supports control of access to entries in the main menu bar and popup menus by 
a system administrator. See the dialog box called by File, Access Control. 

 

Only the items enabled in this dialog box may be accessed by users. This feature is password 

protected using a special Windows® user account named e3238s. 
 

• When this account exists, its password must be used to make access changes. 
 

• When this account does not exist, no restrictions exist for changing access. 
 

To view existing accounts or setup a new one see Start, Run and enter "compmgmt.msc". 
Select the "+" sign next to "Local Users and Groups". 

 

 

Printer Configuration 
 

The N6820ES prints to any printer currently defined on the Windows workstation; see Start, 
Printers and Faxes. To automatically specify a printer other than the default or to set other 

print options (and avoid displaying the print dialog box) see the discussion in the d.print 
file in the N6820ES directory. 
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File System Organization 
 

The application executables are in the c:\e3238s\bin directory. 

The product documentation files are in c:\e3238s\manuals (PDF files). 

The N6820ES software license file(s) are in the c:\e3238s\license directory. 

Error correction files are in c:\e3238s\cal. 

Optional applications each have their own directory. Examples are as follows: 
C:\e3238s\ctcss (CTCSS1 recognition and recording, option PL1) 

C:\e3238s\fm (FM signal recognition and recording, option FMR) 
C:\e3238s\mr1 (modulation recognition, type 1 - wide band) 

C:\e3238s\vad (voice activity detector, HF) 
C:\e3238s\uvad (voice activity detector, VHF/UHF) 
C:\e3238s\pager (pager intercept) 
C:\e3238s\audio (audio output; uses DDC channels & PC audio output) 
C:\e3238s\featureStudio (used to develop feature extraction & energy filter libs) 
C:\e3238s\nbr (narrow-band recorder) 

 
Network Services 

 

To support networked communication between the application and external socket programs, there 
must be an entry in the C:\WINNT\system32\drivers\etc\services file as follows: 
e3238s 7011/tcp 

This defines a sockets port and is usually added during installation. This entry must appear in the 
services file of both the workstation running N6820ES and the remote workstation (the numbers 
must be the same). Verify that the entry exists as shown above. If not, add it. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
1Continuous Tone Coded Squelch System (PL is for ’private line’, a misnomer) 
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Setting the Compiler Environment Variables for option ASD 
 
 
 
 
 
 
 
 
 
 
 

 
Figure 43. 

Visual Studio 

Installation 

The following is required to develop libraries with option ASD: 
 

• Microsoft Visual Studio Ver 6.0 
 

• Microsoft Visual Studio.NET, Ver 7.0 
 

• Microsoft Visual Studio.NET, Ver 8.0 

When installing the Microsoft compiler, we recommend allowing the setup program to register 
the compiler environment variables necessary for command line compilation. See the 
following figure. 

 

 
 
 
If you have already installed Visual Studio 6, Visual Studio.NET Ver 7.0 or Visual 
Studio.NET Ver 8.0, you may need to run the batch file provided to set the environment 
variables. This can be found in the Visual Studio Installation path in these locations, 
depending on your version. The following information assumes the Microsoft Software is 
installed on the C: drive. 

 

• Visual Studio 6.0 - C:\Program Files\Microsoft Visual Studio\VC98\Bin\vcvars32.bat 
 

• Visual Studio .NET Ver 7.0 - C:\Program Files\Microsoft Visual Studio .NET 
2003\Common7\Tools\vsvars32.bat 

 

• Visual Studio .NET Ver 8.0- C:\Program Files\Microsoft Visual Studio .NET 
2005\Common8\Tools\vsvars32.bat 
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User Programming 
 

This section describes how to configure the system to use the User Programming feature, 
option ASD. This procedure establishes access to User Programming features for a single 
user as well as creating directories for shared library development. 

On a Microsoft Windows® system, the application files may be installed wherever the user 
indicates. The default location is the C:\E3238s directory but since this may vary from one 
installation to the next, the label $E3238S is used to indicate the application's home directory 
in the following discussion. 

The include and shared library files are installed in the following directories: 

C:\e3238s\include include files 

C:\e3238s\lib shared library files 

The User Programming example source files are organized under the examples directory. 
Each User Programming shared library type has its own Makefile and directory as follows: 
C:\e3238s\examples\alarmTasks 

C:\e3238s\examples\fileFormats 
C:\e3238s\examples\filterAndFeatures 
C:\e3238s\examples\genericLib 
C:\e3238s\examples\handoffReceiverDriver 
C:\e3238s\examples\sockets 
C:\e3238s\examples\userMenu 

C:\e3238s\examples\userPane 
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Creating a Development Environment 
 

This discussion describes how to create the user programming development environment for 
a single user. The home directory for this user is represented as <HOME>. In the following 
steps, replace <HOME> with the full pathname of the user's home directory. 

 

1. Create the ASD development directory under your <HOME> directory. 

cd <HOME> 

md asd 
 

2. Install and modify your personal copy of the configuration file. 
 

copy <E3238S>\e3238s.cfg <HOME>\e3238s.cfg 

Edit the e3238s.cfg configuration file to enable the socket server and add the existing 
shared libraries: 

energyHistoryFilter:  <HOME>\asd\filterAndFeatures\filterAGE.dll,\ 

<HOME>\asd\filterAndFeatures\filterTEST.dll 

userAlarmTask: <HOME>\asd\alarmTasks\demoUserTask.dll 

featureExtraction: <HOME>\asd\filterAndFeatures\featurePWR.dll,\ 

<HOME>\asd\filterAndFeatures\featureDF.dll 

userMenu: <HOME>\asd\userMenu\userMenu.dll,\ 

<HOME>\asd\userMenu\userMenuCmnd.dll,\ 

<HOME>\asd\userMenu\userMenuArrow.dll 

userPane: <HOME>\asd\userPane\userPane.dll 

genericLib: <HOME>\asd\genericLib\genericLib.dll 

3. Install a personal copy of the application resource file and modify it. 
 

copy <E3238S>\d.E3238s <HOME>\E3238s 

Note that this copies the file and renames it. 
 

Edit the resource file and add the following line specifying the hardware configuration file 
to load when the application starts: 

*hardwareConfiguration: <HOME>\e3238s.cfg 

If you need multiple lines in the toolbar due to adding user-defined menus, add/modify 
the following resources to read: 

*toolbarWrap: True 

*toolbar.paneMaximum: 170 

For more information about application resources see pg 75. 
 

4. Copy the example files (source files) to your private development directory: 
 

cd $Home\asd 

copy /s $E3238S\examples\alarmTasks 

copy /s $E3238S\examples\fileFormats 
copy /s $E3238S\examples\filterAndFeatures 
copy /s $E3238S\examples\genericLib 
copy /s $E3238S\examples\handoffReceiverDriver 
copy /s $E3238S\examples\sockets 
copy /s $E3238S\examples\userMenu 
copy /s $E3238S\examples\userPane 

 

5. Rebuild the object files (dynamic libraries) from the source in your private development 
directory. 
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Hardware Configuration Reference 
 

 
 
 
 
 
 
 

This section describes the hardware parameter settings used in the initialization configuration 
file typically named e3238s.n6841.XXbitOS.cfg, where XX is 32 or 64. This 
file defines the system hardware configuration and is loaded when you start the program. If 
the information in this file does not match the installed configuration, error messages are 
displayed to help isolate the problem. 

Note The N6841A RF Sensor has its own configuration file. Refer to the documentation that came 
with the N6841A RF Sensor for configuration information. 
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df.alias (EDF) 
 
Syntax df(1..8).alias: string 

The maximum length is 31 characters. 

 

Description Specifies an alternate name to be used in the application’s user interface so that the real signal 
name is not displayed. 

 
Example !!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 

! Direction Finding ! 

!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 

df1.enabled: False 

df1.hostLib: C:\E3238s\lib\demoDF.dll 

df1.args: 
df1.alias: NorthPole 
df1.latitude: 
df1.longitude: 
df1.declination: 

df1.heading: 
 

Note You may use either regular slashes (/) or back slashes (\) in the pathname. 
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df.args (EDF) 
 
Syntax df(1..8).args: string 

The maximum length is 255 characters. 

 

Description Specifies the values for any parameters that a custom library might pass in. 
 

Example !!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 

! Direction Finding ! 

!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 

df1.enabled: False 

df1.hostLib: C:\E3238s\lib\demoDF.dll 
df1.args: 45 90 135 180 360 
df1.alias: NorthPole 
df1.latitude: 
df1.longitude: 
df1.declination: 

df1.heading: 
 

Note You may use either regular slashes (/) or back slashes (\) in the pathname. 
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df.declination (EDF) 
 
Syntax df(1..8).declination: float 
 

-180 ≤  float ≤  180 
 

Description Specifies the initial declination at the system location. 
 

Magnetic declination (or magnetic variation) at any point on the earth is an angle that must be 
added to or subtracted from a compass reading to derive true North. 

Values are entered as decimal values. This parameter may be changed in the GUI. 
 

Example !!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 

! Direction Finding ! 

!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 

df1.enabled: False 

df1.hostLib: C:\E3238s\lib\demoDF.dll 
df1.args: 
df1.alias: NorthPole 
df1.latitude: 47.21 
df1.longitude: 75.42 
df1.declination: -15.2 
df1.heading: 80.0 

See Also df.heading (EDF)  
 df.latitude (EDF)  
 df.longitude (EDF)  

Note This parameter is saved as part of the mission state in the current group. If you recall a 
mission state of a different location, this parameter value may be incorrect. 



Hardware Configuration Reference 

44 

 

 

 

df.enabled (EDF) 
 

Syntax df(1..8).enabled: enum 

enum = {False, True} 

Description Specifies whether the direction finding components are to be loaded. This allows you to 
disable a signal library without commenting out all the lines associated with it. 

Another way to disable a signal library is to leave the setting True and just comment out the 
signal.enabled line. 

 
Example The following example shows a DF library that is disabled: 

!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 

! Direction Finding ! 

!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 

df1.enabled: False 
df1.hostLib: C:\E3238s\lib\demoDF.dll 
df1.args: 
df1.alias: NorthPole 
df1.latitude: 47.21 
df1.longitude: 75.42 
df1.declination: -15.2 

df1.heading: 80.0 
 

Note You may use either regular slashes (/) or back slashes (\) in the pathname. 
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df.heading (EDF) 
 
Syntax df(1..8).heading: float 
 

0 ≤  float ≤  360 
 

Description Specifies the initial heading of the DF antenna as taken from a compass reading. 
 

This value can be modified by the declination setting to derive the true heading with respect to 
true North. 

Values are entered as decimal values. This parameter be changed in the GUI. 
 

Example !!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 

! Direction Finding ! 

!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 

df1.enabled: False 

df1.hostLib: C:\E3238s\lib\demoDF.dll 
df1.args: 
df1.alias: NorthPole 
df1.latitude: 47.21 
df1.longitude: 75.42 
df1.declination: -15.2 

df1.heading: 80.0 

See Also df.declination (EDF)  

  df.latitude (EDF)  

  df.longitude (EDF)  

Note This parameter is saved as part of the mission state in the current group. If you recall a 
mission state of a different location, this parameter value may be incorrect. 
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df.hostLib (EDF) 
 

Syntax df(1..8).hostLib: filename 

The maximum length is 127 characters. 

 

Description Specifies the filename of the DF library to be loaded in the host (system controller). This 
provides the host component of the typical host-target interaction mechanism. 

 
Example !!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 

! Direction Finding ! 

!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 

df1.enabled: False 

df1.hostLib: C:\E3238s\lib\demoDF.dll 
df1.args: 
df1.alias: NorthPole 
df1.latitude: 
df1.longitude: 
df1.declination: 

df1.heading: 
 

Note You may use either regular slashes (/) or back slashes (\) in the pathname. 
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df.latitude (EDF) 
 
Syntax df(1..8).latitude: float 
 

-90 ≤  float ≤  90 
 

Description Specifies the initial latitude position of the system. 

Values are entered as decimal values. 
Negative values indicate a location in the Southern Hemisphere. This 
may be changed in the GUI. 

 
Example !!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 

! Direction Finding ! 

!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 

df1.enabled: False 

df1.hostLib: C:\E3238s\lib\demoDF.dll 
df1.args: 
df1.alias: NorthPole 
df1.latitude: 47.21 
df1.longitude: 72.45 
df1.declination: 

df1.heading: 
 

See Also df.declination (EDF) 
  df.heading (EDF) 
  df.longitude (EDF) 

 
 

Note This parameter is saved as part of the mission state in the current group. If you recall a 
mission state of a different location, this parameter value may be incorrect. 
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df.longitude (EDF) 
 
Syntax df(1..8).longitude: float 
 

-180 ≤  float ≤  180 
 

Description Specifies the initial longitude location of the system. This may be changed in the GUI. 

Values are entered as decimal values. Negative values indicate the Western Hemisphere. 

 

Example !!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 

! Direction Finding ! 

!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 

df1.enabled: False 

df1.hostLib: C:\E3238s\lib\demoDF.dll 
df1.args: 
df1.alias: NorthPole 
df1.latitude: 47.21 
df1.longitude: 75.42 
df1.declination: 

df1.heading: 
 

See Also df.declination (EDF) 
  df.heading (EDF) 
  df.latitude (EDF) 

 

 

Note This parameter is saved as part of the mission state in the current group. If you recall a 
mission state of a different location, this parameter value may be incorrect. 
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disableAccess 
 

Syntax disableAccess: string 
 

The maximum length is 255 characters. 

 

Description Specifies which items in the menu bar pulldown menus are inactive at startup. This allows 
the control of access to the main menu features. 

The argument is a string containing the name of the menu label exactly as it appears in the in 
the pulldown menu. See the following example. Note that multiple strings passed to this 
command are not delimited by commas. Only spaces separate the values. 

 
Example The following commands disable user control of one entry in the File menu and all entries in 

the Edit menu: 

disableAccess: Secure Display 
disableAccess: Log Files ... 
disableAccess: Clear Log 
disableAccess: Clear Log File 
disableAccess: Clear Energy History 
disableAccess: Clear Signal Database 
disableAccess: Clear Frequency Lists 
disableAccess: Clear Audio Output 
disableAccess: Clear All 

 

The user may change the menu access status by entering the password for user e3238s when 
prompted. 

 

i. Menu access control exists in the GUI in the File, Access Control ... dialog box. There 
is no password control unless there is a user defined as 'e3238s'. 

 
See Also enableAccess 
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e3238sService 
 

Syntax e3238sService: string 
 

The maximum length is 79 characters. 

 

Description Specifies the name of the service used to define the port number and service provided. Socket 
server services are listed in a file: For Windows systems, the file is 

\WinNT\system32\drivers\etc\Services. 

The line in the file may look like this: 

e3238s 7011/tcp 

The default value of this parameter is e3238s. 
 

Example The following commands show an example socket configuration: 
 
 

e3238sService: e3238s 
e3238sServiceMaxConnections: 4 
e3238sServiceDataBufferSize: 512 
e3238sServiceSendBufferSize: 0 

e3238sServiceRecvBufferSize: 0 
 

 
 

See Also e3238sServiceDataBufferSize 
e3238sServiceMaxConnections 
e3238sServiceRecvBufferSize 
e3238sServiceSendBufferSize 

maxClientSockets 
maxServices 
socketServer 
socketServerTimerInterval 
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e3238sServiceDataBufferSize 
 
Syntax e3238sServiceDataBufferSize: integer 
 

512 ≤  integer ≤  4194304 
 

Description Specifies the maximum size of the buffer used to hold incoming data (from the sockets 
receive buffer). For the E3238S, this data amounts to incoming commands. 

The default value of this parameter is 512. 
 

Example The following commands show an example socket configuration: 
 
 

e3238sService: e3238s 
e3238sServiceMaxConnections: 4 

e3238sServiceDataBufferSize: 512 
e3238sServiceSendBufferSize: 0 

e3238sServiceRecvBufferSize: 0 
 
 

See Also e3238sService 
e3238sServiceMaxConnections 
e3238sServiceRecvBufferSize 
e3238sServiceSendBufferSize 

maxClientSockets 
maxServices 
socketServer 
socketServerTimerInterval 
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e3238sServiceMaxConnections 
 
Syntax e3238sServiceMaxConnections: integer 
 

1 ≤  integer ≤  10 
 

Description Specifies the maximum number of server sockets available on the host. The Sockets Connections 
dialog box shows the maximum number of connections and any clients connected to the 
N6820ES service. 

This parameter's default value is 4. 
 

This setting has no impact on the socketServerClientSockets parameter. In fact, a more 
appropriate name would be socketServerMaxServerSockets. 

 

 
 
 
 
 
 

 
Figure 47. 

Example The following commands show an example socket configuration: 

e3238sService: e3238s 

e3238sServiceMaxConnections: 4 
e3238sServiceDataBufferSize: 512 
e3238sServiceSendBufferSize: 0 

e3238sServiceRecvBufferSize: 0 
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e3238sServiceRecvBufferSize 
 

Syntax e3238sServiceRecvBufferSize: integer 
 

0 ≤  integer ≤  8388608 

 
Description Specifies the number of bytes to allot for the purpose of receiving packets at the operating 

system level. 

The default value for this parameter is 0 which allows the system to adjust the actual value 
used to match the conditions. The default value for Windows® is 8192. 

 
Example The following commands show an example socket configuration: 

e3238sService: e3238s 
e3238sServiceMaxConnections: 4 

e3238sServiceDataBufferSize: 512 

e3238sServiceSendBufferSize: 0 

e3238sServiceRecvBufferSize: 0 
 

 
 

See Also e3238sService 
e3238sServiceDataBufferSize 
e3238sServiceMaxConnections 
e3238sServiceSendBufferSize 

maxClientSockets 
maxServices 
socketServer 
socketServerTimerInterval 
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e3238sServiceSendBufferSize 
 
Syntax e3238sServiceSendBufferSize: integer 
 

0 ≤  integer ≤  8388608 
 

Description Specifies the number of bytes to allot to for the purpose of sending packets. This allows you 
to select a value to optimize performance given the data rate of the LAN. If the rate is low 
you may want to choose a large value for this parameter. 

 

The default value for this parameter is 0 which allows the system to adjust the actual value used 
to match the conditions. The default value for Windows® is 8192. 

 
Example The following commands show an example socket configuration: 

e3238sService: e3238s 
e3238sServiceMaxConnections: 4 

e3238sServiceDataBufferSize: 512 

e3238sServiceSendBufferSize: 0 
e3238sServiceRecvBufferSize: 0 

 

 
 

See Also e3238sService 
e3238sServiceDataBufferSize 
e3238sServiceMaxConnections 
e3238sServiceRecvBufferSize 

maxClientSockets 
maxServices 
socketServer 
socketServerTimerInterval 
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enableAccess 
 
Syntax enableAccess: string 
 

The maximum length is 255 characters. 

 

Description Used to restore access to features within the E3238S application that have been restricted 
through use of the disableAccess. You can also choose to just comment out the 
disableAccess lines in the e3238s.cfg file 

 

 
 
See Also disableAccess 
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energyHistoryFilter 
 

 Syntax 
 

energyHistoryFilter: filename 
 
The maximum length is 511 characters. 

Description Specifies path and filename(s) of shared library program(s) used to filter entries in the 

 Energy History. 

 As many as 16 filter definitions may be loaded but no more than 5 of each type (pre or post) 

 may be active at a time. 

Notes  If a library contains code for both features and filters, use the same name with both 

  commands. 

  Either regular slashes (/) or back slashes (\) may be used in the pathname. 

  
Example 

 
energyHistoryFilter: /e3238s/filterBUTCH.dll, \ 

  /e3238s/filterSUNDANCE.dll 

 

featureExtraction: /e3238s/featureBUTCH.dll, \ 

/e3238s/featureSUNDANCE.dll 
 

 
 
 

See Also featureExtraction 
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featureExtraction 
 

 Syntax 
 

featureExtraction: filename 
 
The maximum length is 511 characters. 

Description Specifies path and filename(s) of shared library program(s) used to extract features from raw 

 spectral search data. 

Example 
 

featureExtraction: /e3238s/featureBUTCH.dll, \ 

/e3238s/featureSUNDANCE.dll 

 As many as 4 feature shared libraries may be loaded, each of which may define as many as 4 

 features. 

Note  If one shared-library program contains code for both features and filters, use the same name 

  with both commands. 

 
Note 

 You may use either regular slashes (/) or back slashes (\) in the pathname. 

  
See Also 

 
energyHistoryFilter 
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genericLib 
 

Syntax genericLib: filename 
 

The maximum length is 511 characters. 

 

Description Specifies a shared library comprising features that do not belong in any of the specific user- 
defined categories such as panes, feature types, feature filters, alarm tasks, and signal 
processing. 

As many as four generic shared libraries may be loaded. 
 

Example genericLib: C:/e3238s/examples/doItAll.dll 
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handoffRx.driver 
 

Syntax handoffRx(1..16).driver: filename 
 

The maximum length is 79 characters. 

 

Description Specifies the shared-library file containing the driver code for a specific handoff receiver. 

As many as 100 handoff receivers may be controlled by the system. The number 16 that 
appears in the syntax above is determined by the maxHandoffRxs parameter setting in the 
resource file. An error occurs when you specify more than this setting. 

 
Example The following commands define the hardware configuration for a handoff receiver. 

handoffRx1.driver: C:/e3238s/lib/HD_8607.dll 
handoffRx1.interface: rs232,COM1,9600 
handoffRx1.label: VHF/UHF Rx 

 
See Also handoffRx.interface 

handoffRx.label 
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handoffRx.interface 
 

Syntax handoffRx(1..16).interface: string 
 

The maximum length is 63 characters. 

 

Description Specifies the interface type connecting the handoff receiver to the system. Some examples 
are hpib, vxi, and com1. 

As many as 100 handoff receivers may be controlled by the system. The number 16 that 
appears in the syntax above is determined by the maxHandoffRxs parameter setting in the 
resource file. An error occurs when you specify more than this setting. 

 
Example The following commands define the hardware configuration and driver program for a 

handoff receiver: 

handoffRx1.driver: C:/e3238s/lib/HD_8607.dll 
handoffRx1.interface: rs232,COM1,9600 
handoffRx1.label: VHF/UHF Rx 

 

Note When using a controller with a firewire interface, use “ASRL1” instead of “COM1” in the 
interface parameter. (The firewire IO interface does not support an alias for the serial port 
name.) 

 

 
See Also handoffRx.driver 

handoffRx.label 
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handoffRx.label 
 

Syntax handoffRx(1..16).label: string 
 

The maximum length is 31 characters. 

 

Description Specifies a label for the handoff receiver listing in the handoff receiver pane. 

As many as 100 handoff receivers may be controlled by the system. The number 16 that 
appears in the syntax above is determined by the maxHandoffRxs parameter setting in the 
resource file. An error occurs when you specify more than this setting. 

 
Example handoffRx1.driver: C:/e3238s/lib/HD_8607.dll 

handoffRx1.interface: rs232,COM1,9600 
handoffRx1.label: VHF/UHF Rx 

 
See Also handoffRx.label 

handoffRx.interface 
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maxClientSockets 
 
Syntax maxClientSockets: integer 
 

0 ≤  integer ≤  16 
 

Description Specifies the maximum number of client sockets that can be open in the application. 
The default is 0. However, a user-defined library may use client sockets to connect to 
external services (typically on other systems). 

Figure 48 illustrates the socket startup process and the various socket types. The number of 
’listen sockets’ corresponds to the maxServices setting. 

This setting has no impact on the e3238sServiceMaxConnections parameter. 
 

 
 
 
 
 

Figure 48. 
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socketServer 
socketServerTimerInterval 
e3238sService 
e3238sServiceDataBufferSize 
e3238sServiceMaxConnections 
e3238sServiceRecvBufferSize 
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maxServices 
 

Syntax maxServices: integer 
 

1 ≤  integer ≤  5 
 

Description Specifies the number of sockets used to listen for connections. 

The default value of this parameter is 1. 

Only one listen socket is required for 1-10 clients to the N6820ES service. 

There should be 1 listen socket for every service provided by the system (see 

\WINNT\system32\drivers\etc\services). 

This number may be incremented to support additional socket services implemented through 
user-defined shared-library programs. 

 

 
 
 
 
 

Figure 49. 
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socketServer 
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e3238sService 
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e3238sServiceSendBufferSize 



Hardware Configuration Reference 

64 

 

 

 

modRec.alias 
 

Syntax modRec(1..32).alias: string 

The maximum length is 31 characters. 

 

Description Specifies an alternate name to be used in the application’s user interface so that the real signal 
name is not displayed. 

 
Example !!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 

! Modulation Recognition ! 

!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 
 

modRec1.enabled: False 
modRec1.hostLib: C:\E3238s\mr1\mr1.dll 

modRec1.args: 

modRec1.alias: Bob 
 

Note You may use either regular slashes (/) or back slashes (\) in the pathname. 
 

 
See Also modRec.args (MR1) 

modRec.enabled (MR1) 
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modRec.args 
 

Syntax modRec(1..32).args: string 

The maximum length is 255 characters. 

 

Description Specifies the values for any parameters that a custom library might pass in. 
 

Example !!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 

! Modulation Recognition ! 

!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 
 

modRec1.enabled: False 
modRec1.hostLib: C:\E3238s\mr1\mr1.dll 
modRec1.args: 

modRec1.alias: Bob 
 

Note You may use either regular slashes (/) or back slashes (\) in the pathname. 
 

 
See Also modRec.alias (MR1) 

modRec.enabled (MR1) 
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modRec.enabled 
 

Syntax modRec(1..32).enabled: enum 

enum = {False, True} 

Description Specifies whether the signal processing components are to be loaded. This allows you to 
disable a signal library without commenting out all the lines associated with it. 

Another way to disable a signal library is to leave the setting True and just comment out the 
signal.enabled line. 

 
Example The following example shows a signal that is disabled: 

!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 

! Modulation Recognition ! 

!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 
 

modRec1.enabled: False 
modRec1.hostLib: C:\E3238s\mr1\mr1.dll 
modRec1.args: 

modRec1.alias: Bob 
 

Note You may use either regular slashes (/) or back slashes (\) in the pathname. 
 

 
See Also modRec.alias (MR1) 

modRec.args (MR1) 
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modRec.hostLib 
 

Syntax modRec(1..32).hostLib: filename 

The maximum length is 127 characters. 

 

Description Specifies the filename of the Mod Rec library to be loaded in the host (system controller). 
This provides the host component of the typical host-target interaction mechanism. 

 
Example !!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 

! Modulation Recognition ! 

!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 
 

modRec1.enabled: False 
modRec1.hostLib: C:\E3238s\mr1\mr1.dll 
modRec1.args: 

modRec1.alias: Bob 
 

Note You may use either regular slashes (/) or back slashes (\) in the pathname. 
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socketServer 
 

Syntax socketServer: enum 
 

enum = {Disabled, Enabled} 

 

Description Specifies whether the sockets feature is active. 

The default value of this parameter is Disabled. 
 

Example The following commands show an example socket configuration: 

socketServer: Enabled 
maxServices: 1 
maxClientSockets: 0 

socketServerTimerInterval: 5 
 
 

See Also maxClientSockets 
maxServices 
socketServerTimerInterval 
e3238sService 
e3238sServiceDataBufferSize 
e3238sServiceMaxConnections 
e3238sServiceRecvBufferSize 
e3238sServiceSendBufferSize 
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socketServerTimerInterval 
 

Syntax socketServerTimerInterval: integer 
 

1 ≤  integer ≤  10000 
 

Description This specifies how often the system checks for the presence of sockets data. 

Units are milliseconds. 

Default value is 5 ms. 

 
 

Example The following commands show an example socket configuration: 

socketServer: Enabled 

maxServices: 1 
maxClientSockets: 0 

socketServerTimerInterval: 5 
 
 

See Also maxClientSockets 
maxServices 
socketServer 
e3238sService 
e3238sServiceDataBufferSize 
e3238sServiceMaxConnections 
e3238sServiceRecvBufferSize 
e3238sServiceSendBufferSize 
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timeCorrectionMaxBlocksize 
 

Syntax timeCorrectionMaxBlocksize: integer 
 

1 ≤  integer ≤  2147483647 
 

Description Specifies the maximum block size for applying Time Corrections. 
 

When Time Correction processing is enabled, time snapshot files larger than this value will 
not be corrected. If not specified, this defaults to 16 Mega-samples. 

Time correction processing is performed on the host computer and is memory intensive, 
requiring 8 bytes for each sample. 

This value can be increased if large corrected capture files are needed, but the host computer 
should have adequate physical memory available. 
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userAlarmTask 
 

Syntax userAlarmTask: filename 
 

The maximum length is 511 characters. 

 

Description Specifies the user-defined alarm task (shared-library) program to load. 
 

Example userAlarmTask: C:\e3238s\userTaskEmail.dll 
 

Note You may use either regular slashes (/) or back slashes (\) in the pathname. 
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userMenu 
 

Syntax userMenu: filename 
 

The maximum length is 511 characters. 

 

Description Specifies the user-defined menu shared-library program to load. 
 

As many as 4 user-defined menu bar entries may be defined, each with as many as 8 menu entries. 
 

Example userMenu: C:/e3238s/examples/userMenu/userMenu.dll,\ 

C:/e3238s/examples/userMenu/userMenuArrow.dll 
 

Note You may use either regular slashes (/) or back slashes (\) in the pathname. 
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userPane 
 

 Syntax 
 

userPane: filename 
 
The maximum length is 511 characters. 

Description Specifies the user-defined shared library that implements a custom window pane. 

 The maximum number of user-defined panes allowed is 4. 

 To display a pane, add it to the application window with the layout.pane.type 
command. 

Example 
 

userPane: C:/e3238s/examples/userPane/userPane.sl 

Note  You may use either regular slashes (/) or back slashes (\) in the pathname. 
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userThreshold 
 

Syntax userThreshold: filename 
 

The maximum length is 511 characters. 

 

Description Specifies the user-defined shared library that implements a custom threshold algorithm. 
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Application Resources 
 

 
X Window applications can declare variables such that their values may be set in an external 
ASCII file. These settings are called resources. The E3238s file is an application resource 
file. The entries in this file define fonts, colors, line thickness, window sizes, file lengths, path 
names, and many other things for each part of the N6820ES program. Other application 
parameters defined in this file are: 

• Application Resource file used (see Appendix A: d.E3238s Listing) 
• Hardware configuration file listing (see Appendix B: d.e3238s.cfg Listing 
• Function key definitions 
• Accelerator key definitions 
• Memory usage parameters 
• Capacity of the log views 
• Titles of trace panes and the handoff log pane 

This allows you to change how the program looks and works without changing a program 
source file and recompiling. For more information about Motif resources, see one of the many 
Motif references available such as X Toolkit Intrinsics Programming Manual, Volume Four of 
the X Window Series by O’Reilly & Associates. 

 

When you first install the software, no resource file exists. Instead, a file named d.E3238s 
is created in the e3238s directory (“d” is for default). This avoids overwriting an existing 
file when the “installation” is really an update. So, after performing an installation on a new 
disk, you may need to copy this file to create a file named N6820ES. 

 
Custom Resources When the program starts it uses the first resource file it finds; the order of the search is as 

follows: 

1. User Profile directory 
2. User HOME directory 

3. E3238s directory (as defined during installation) 

4. Standard Exceed locations (e.g., XUSERFILESEARCHPATH) 
 

If no file is found, fallback resources defined in the program are used. See also, the discussion 
above. 

Any values specified on the command line with the -xrm option are loaded for that instance 
of the program and override any conflicting variable settings specified in the resource files. 
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You can specify a resource when you start the program by using the -xrm option as follows: 
e3238s -xrm resourcestring 

This option specifies a resource name and value to override any defaults. It is also very useful for 
setting resources that don't have explicit command line arguments. 

It is recommended that you start by copying the E3238s file into your home directory. This 
allows users to have custom configurations. 

Widget resources, such as fonts and colors, can be set for most widgets in this software. The 
widget hierarchy can be printed from the File menu. 

Application resources are those resources created specifically for this application and are not 
part of the OSF/Motif widget set. If these resources are not specified, their default values are 
used. The application resources are described below: 

 

alarmLogViewLength   type: Integer   default: 100 
 

Specifies the number of alarm entries to keep in the alarm log view. Each handoff requires 
approximately 90 bytes of memory. 

Example: *alarmLogViewLength: 400 
 

audioOutput   type: XmRString default: 0 
 

Specifies the location of the audio output. The default is the same location that the N6820ES 
code is executing on. 

 

clientTitles   type: Boolean default: False 

Specifies whether to put titles on dialog boxes. 

commandHelpVolume   type: XmRString 

default: 

*commandHelpVolume: <E3238s_home>/help/CommandRef 

Specifies the help volume for E3238s commands. 
 

Note Windows® path names must use either / or \\ character delimiters. 

 
commandLineEnabled type: Boolean default: True 

Specifies whether to enable the command line pane. 

Example: *commandLineEnabled: True 

commandLineHistoryLength   type: Integer   default: 100 
 

Specifies the number of commands to keep in the command line history. Each command 
requires approximately 80 bytes of memory. 

Example:  *commandLineHistoryLength: 300 
 

dataBufferSize   type: Integer   default: 8,000,000 

Specifies the amount of memory to allocate for data storage in terms of data points. Each data 
point is 4 bytes. To sweep from 2 MHz to 2.65 GHz with a 940 Hz RBW, the amount of 
memory required is calculated as follows: 
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1. Find the bin spacing. The following tables show the relationship between shape factor, 
bin spacing, and RBW. 

RBW (Hz) vs. Bin Spacing and Shape Factor 

| | Shape Factor | 
| Bin Spacing | 9.0:1 | 4.0:1 | 2.6:1 | 
|-------------|-------|-------|-------| 
| 80,000.0 | 120 k | 177 k | 305 k | 
| 40,000.0 |  60 k | 88 k | 152 k | 
| 20,000.0 |  30 k | 44 k |  76 k | 
| 10,000.0 |  15 k | 22 k |  38 k | 
|  5,000.0 | 7.5 k | 11 k |  19 k | 
|  2,500.0 | 3.8 k | 5.5 k | 9.6 k | 
|  1,250.0 | 1.9 k | 2.8 k | 4.8 k | 
| 625.0 | 940 | 1.4 k | 2.4 k | 
| 312.5 | 470 | 700 | 1.2 k | 

| 156.25 | 240 | 350 | 600 | 
| 78.125 | 120 | 180 | 300 | 
| 39.0625 | 60 | 90 | 150 | 
| 19.5313 | 29 | 43 | 80 | 
| 9.7656 | 15 | 22 | 37 | 

| 4.8828 | 7.3 | 11 | 19 | 
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2. Next, calculate the number of frequency points. 
 

num points = (Stop Frequency - Start Frequency)/ Bin Spacing 

For our example this would be: 

num points = (2.65 GHz - 2 MHz) / 625 num 

points = 4,236,800 

3. Now, calculate the host computer memory required. 
 

num data points = num points ×  bytes required per data point 

For our example this would be: 

bytes = 4,236,800 ×  4 

bytes = 16,947,200 

For this example, almost 17 MB of RAM is required. The value you would assign to the 
resource is in points. 

Example:  *dataBufferSize: 4,300,000 

The software fails when it cannot allocate the amount of memory you specify. 
 

defaultAudioExtension   type: XmRString default: *.wav 

Specifies the default extension for audio files. The possible audio extensions are: 

*.u MuLaw (u-law) 
*.al ALaw (A-law) 
*.au Sun (NeXT) 
*.wav Microsoft RIFF waveform 
*.snd Next 
*.l16 Linear16 (16-bit signed) 
*.l8 Linear8 (8-bit signed) 
*.lo8 Linear8Offset (8-bit unsigned) 

 

displayLocalTime   type: Boolean default: True 
 

Specifies whether time information is displayed using the local timezone information. When 
False, time values are displayed as GMT. 

 

e3238sIconPixmap   type: XmRString default: none 

Specifies a pixmap file to be used as an icon. 

enableAudio   type: Boolean default: True 

Specifies whether the audio output is enabled. 

enhancedSpectrogramMarker   type: Boolean default: True 

Enables the enhanced spectrogram marker. 

enhancedSpectrumMarker   type: Boolean default: False 

Enables the enhanced spectrum marker that adds time information to the marker information. 
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gridBitmap   type: XmRString 

default: 

*gridBitmap: <E3238S_home>/bitmaps/grid.bm 

Specifies the grid bitmap used when displaying the handoff frequencies. The handoff 
frequency is displayed as a solid line and, as bandwidth increases, the trace area is filled with 
this bitmap. See following note. 

 

hardwareConfiguration   type: XmRString 

default: 

<E3238S_home>/e3238s.cfg 

Specifies the hardware configuration file. See note below. 

Example: *hardwareConfiguration: /E3238s/e3238s.cfg.mine 

You can also start the program with the -xrm flag and specify this file. This is very useful for 
specifying multiple startup icons, each with a different configuration file and/or initial state 
(specified with the -missionState flag). 

 

handoffLogViewLength   type: Integer default: 500 
 

Specifies the number of handoffs to keep in the handoff log view. Each handoff requires 
approximately 160 bytes of memory. 

 

handoffPaneFont   type: XmRString default: 7x14 

Specifies the font used by spreadsheet area of the handoff receiver pane. 
 

hideDisplay   type: Boolean default: False 
 

Prevents the software from displaying an X window.  Error messages are displayed. See also 
remoteMode. 

 

help4helpVolume   type: XmRString default: Help4Help Specifies 

the help volume that provides help for help. 

helpVolume   type: XmRString 

default: 

<E3238S_home>/help/e3238s 

Specifies the help volume. 
 

Note Windows® path names must use either / or \\ character delimiters. 

 
logViewFont   type: XmRString default: 7x14 

Specifies the fonts for the log views. A fixed spaced font should be used. 
 
 

maxEnergyHistorySize   type: Integer default: 5000 
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Specifies the maximum number of entries the energy history can contain. When this limit is 
reached, no new entries can be added to the energy history until some are deleted or the entire 
energy history is cleared. Each entry is about 128 bytes. 

 

maxHandoffRxs   type: Integer default: 16 
 

Specifies the maximum number of handoff receivers that can be controlled at one time. The 
maximum number is 100. 

 

maxSpectrogramColors   type: Integer default: 32 
 

Specifies the maximum number of colors cells to allocate for the color spectrogram display. The 
maximum allowable is 128. 

 

multiClickTime   type: integer default: 200 

Specifies the mouse double-click time in milliseconds. 
 

newEnergyLogViewLength   type: Integer default: 1000 
 

Specifies the number of new energy entries to keep in the new energy log view. Each handoff 
requires approximately 60 bytes of memory. 

 

openCommandPort   type: String default: none 

Specifies a command port program to run at power up. 

openScreenTime   type: Integer default: 5 

Specifies the amount of time the opening screen remains open. 
 

overloadColor   type: XmRString default: red 
 

Specifies the color of the trace ID displayed when an ADC overload occurs. If no value is set, 
the trace ID color does not change when an overload condition occurs. 

 

ownColormap   type: Boolean default: False 

Enables the software to use its own colormap. This is useful when there are not enough colors 
available in the system colormap. On computers that have a dual hardware colormap system 
it works well. However, on single hardware colormap systems, going into and out of the 
E3238S window causes harsh color usage for the window without focus. 

You can also use the -ownColormap flag when stating the program from the prompt. 
 

plotColorBackground   type: XmRString default: Black 

Specifies the color used for the background in the energy history plot window. 
 

plotColorTrace   type: XmRString default: White 

Specifies the color used for the trace in the energy history plot window. 
 

plotColor1   type: XmRString default: Yellow 

Specifies the color used for the marker in the energy history plot window. 
 

plotColor2   type: XmRString default: Green 

Specifies the color used for the average value in the energy history plot window. 
 

plotColor3   type: XmRString default: gray60 
 

Specifies the color used for the minimum to maximum range in the energy history plot window. 
 

powerOnSweep   type: Boolean default: True 
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Specifies whether to start sweeping when the software is first started. 
 

powerUpMissionSetup   type: XmRString default: 
 

When a filename is specified, the software's initial state is defined by the mission setup 
contained in this file. 

 

remoteMode   type: Boolean default: False 

Prevents the software from displaying an X Window as well as error or message dialog boxes. 
This allows programs that use N6820ES output and need no control via the graphic user 
interface (e.g., socket port information) to suppress the normal application window. Any 
unwritten information at exit time is deleted without warning. 

See also, hideDisplay. 
 

signalDatabaseSize   type: Integer default: 500000 
 

Specifies the maximum number of signal database entries allowed. When this maximum 
number of entries is reached, no new entries are recorded. 

 

spectrogramBackingStoreSize   type: Integer default: 100000 

Specifies the amount of memory, in bytes, to use for storing the spectrogram and color 
spectrogram display. This is used when the spectrogram needs to be redisplayed such as when 
a dialog box is removed from being on top of trace area. This amount of memory is used for 
each of the four traces. The amount of memory needed for the spectrogram per trace can be 
computed by: 

MW = maximum width of the trace (in pixels) 
ML = maximum height of the trace (in pixels) 

memory required (in bytes) = MW * ML / 8 

The amount of memory needed for the color spectrogram per trace can be computed by 
MW = maximum width of the trace (in pixels) 
ML = maximum height of the trace (in pixels) 

memory required (in bytes) = MW * ML * 4 

At least 5120 bytes of memory is required for each trace. 
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spectrogramBackingStoreSizeTraceA   type: Integer default: 2000000 

spectrogramBackingStoreSizeTraceB   type: Integer default: 0 spectrogramBackingStoreSizeTraceC   

type: Integer default: 0 spectrogramBackingStoreSizeTraceD   type: Integer default: 0 

This is a companion resource with 'spectrogramBackingStoreSize'. Since the color 
spectrogram requires a large amount of memory for a full backing store, you may want to 
allocate individual trace values. When the value specified is zero, the trace uses the 

spectrogramBackingStoreSize value. 
 

syncDisplayEnabled   type: Boolean default: True 

Enables the software to do a synchronization with the X server at the end of every sweep. This 
should always be True except when running over a communications link that has a very long 
message round trip time. 

 

toolbarWrap   type: Boolean default: False 
 

Specifies whether the toolbar icons wrap to a new row or truncate at the end of a single row of 
icons. 

To allow sizing of the toolbar pane when toolbarWrap is True, the resource 

toolbar.paneMaximum should be increased to view the maximum number of rows. 
 

tooltips   type: Boolean default: True 

Specifies whether to display the toolbar tooltips. 
 

traceBackgroundColor   type: XmRString default: Black Specifies 

the background color for all traces. 

traceFont   type: XmRString default: 9x15 

Specifies the font used for labeling that appears within the trace. 
 

traceGridColor   type: XmRString default: Gray50 Specifies 

the grid color for all traces. 

traceLabelColor   type: XmRString default: White Specifies 

the label color for all traces. 

traceLineColor   type: XmRString default: cyan3 

Specifies the line color for all traces. 

traceMarkerColor   type: XmRString default: Yellow Specifies 

the marker color for all traces. 

traceThresholdColor   type: XmRString default: Blue Specifies 

the threshold color for all traces. 
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traceTranslations   type: XmRString default: 

Specifies translations for the traces. A common use of these translations is to map function 
keys to various command line functions. An action routine, commandLine(), is provided to 
send strings to the command line of this software. For a list of commands available, see the 
Command Reference (a PDF file). 

Example: 

*traceTranslations: #override\ 

<Key>F2: commandLine(“*frequencyFullScale”)\n\ 
<Key>F3: commandLine("*amplitudeAutoScale")\n\ 
<Key>F4: commandLine("*markerMode:on")\n\ 
<Key>F5: commandLine("*markerMode:off")\n\ 
<Key>F6: commandLine("*frequencyFullScale","*amplitudeAutoScale")\n 

This example maps five function keys as follows: 

• F2 to do a frequency full scale 
• F3 to do a amplitude auto scale 
• F4 to turn the marker on 
• F5 to turn the marker off 
• F6 to do both an amplitude and frequency auto scale. 

 

transientTitles   type: Boolean default: False 

Specifies whether to put titles on transient dialog boxes. 
 

useHardware   type: Boolean default: True 
 

Specifies whether or not to use the RF Sensor hardware. When True, energy data is random. 
You can also start the program with the -noHardware flag. 

 

useOldTimeSnapshotFileFormat   type: Boolean default: False 

The software starting with version C.00.01 implements a new time snapshot file format to 
allow file sizes larger than 1 GB. To save time snapshot files in the old format, set this value 
to true. You will not be able to save a file larger than 1 GB. 

 

userColorMapEnabled   type: Boolean default: False 

Enables user color map code. 
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Specifications 
 

 
 
 
 
 
 
 

Definitions 
 

Specifications Specifications describe the performance of parameters covered by the product warranty 
 

Characteristics Characteristics describe the product performance that is useful in the application of the 
product, but is not covered by the product warranty. 

 
Typical Typical indicates performance within specification that 80% of the units exhibit with a 80% 

confidence level over the temperature range 20 to 30 °C. Typical specifications are not 
covered by product warranty. 

 
Nominal Nominal values indicate the level that all units are expected to surpass over the specified 

environmental operating range. Nominal specifications are not covered by product warranty. 
 

Supplemental 

Information 

Supplemental information encompasses characteristics, typical, nominal, and other 
information pertinent to understanding the expected, but unwarranted, performance of a 
given parameter. 

 

Recommended 

Calibration 

Interval 

The recommended calibration interval is the period after its last calibration during which a 
product is expected to meet its specified parameters. The recommended calibration interval is 
expressed in months or years. 

 

Calibration Calibration, as Agilent defines it, is the process of verifying that the product meets its 
warranted specifications and performing adjustments as necessary to either correct any out- 
of-tolerance conditions or better optimize a parameter to improve the probability that the 
parameter will be in-tolerance at the calibration. 

 

Room 

Temperature 

Room temperature is generally accepted to be the range from 20 to 30 °C. 



Application Resources 

85 

 

 

Conditions, Certification, and Calibration 
 

 

Conditions Required to Meet Specifications. 
 

All conditions must be met. 
 

• The product is being operated within the specified conditions for temperature, altitude, and 
humidity 

 

• Any system components that specify a calibration cycle must calibrated 
 

• Spectrum Corrections must be enabled in the software application 
 

• The product has been warmed up for at least 30 minutes. 
 

 

Certification 
 

Agilent Technologies certifies that this product met its published specifications at the time of 
shipment from the factory. Agilent Technologies further certifies that its calibration 
measurements are traceable to the United States National Institute of Standards and 
Technology, to the extent allowed by the Institute’s calibration facility, and to the calibration 
facilities of other International Standards Organization members. 
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Safety Summary 
 

The following general safety precautions must be observed during all phases of operation, 
service, and repair of this product. Failure to comply with these precautions or with specific 
warnings elsewhere in this manual violates safety standards of design, manufacture, and 
intended use of the product. Agilent Technologies, Inc. assumes no liability for the customer's 
failure to comply with these requirements. 

Refer to the RF Sensor product documentation for specific instructions. 
 

WARNINGS Ground the equipment: For Safety Class 1 equipment (equipment having a protective earth 

terminal), an uninterruptible safety earth ground must be provided from the mains power source 

to the product input wiring terminals or supplied power cable. 

 
DO NOT operate in an explosive atmosphere 

Do not operate the instrument in the presence of flammable gases or flames. 

 
For continued protection against fire, replace the line fuse(s) only with fuse(s) of the same voltage 

and current rating and type. DO NOT use repaired fuses or short-circuited fuse holders. Refer to 

the operation and service documentation for the RF Sensor for information on the power 

supply specifications, grounding, and ventilation requirements. 

 
Keep away from live circuits: Operating personnel must not remove equipment covers or shields. 

Procedures involving the removal of covers or shields are for use by service-trained personnel only. 

Under certain conditions, dangerous voltages may exist even with the equipment switched off. To 

avoid dangerous electrical shock, DO NOT perform procedures involving cover or shield removal 

unless you are qualified to do so. 

 
DO NOT operate damaged equipment: Whenever it is possible that the safety protection features 

built into this product have been impaired, either through physical damage, excessive moisture, or 

any other reason, REMOVE POWER and do not use the product until safe operation can be verified 

by service-trained personnel. If necessary, return the product to an Agilent Technologies Sales and 

Service Office for service and repair to ensure that safety features are maintained. 

 
If the equipment is used in a manner not specified by Agilent Technologies, the protection 

provided by the equipment may be impaired. 

 
DO NOT service or adjust alone: Do not attempt internal service or adjustment unless another 

person, capable of rendering first aid and resuscitation, is present. 

 
DO NOT substitute parts or modify equipment: Because of the danger of introducing additional 

hazards, do not install substitute parts or perform any unauthorized modification to the product. 

Return the product to a Agilent Sales and Service Office for service and repair to ensure that safety 

features are maintained. 

 
Cleaning: To prevent electrical shock, disconnect the system from the mains power before 

cleaning. Us a dry cloth or one slightly dampened with water to clean the external case parts. Do 

not attempt to clean internally. 
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Caution DO NOT remove the module covers. 

Operating personnel must not remove module covers. Component replacement and internal 

adjustments must be made only by qualified service personnel. Modules that appear damaged 

or defective should be made inoperative and secured against unintended operation until they 

can be repaired by qualified service personnel. 
 

 
 
 

Laser Safety 
 

This product contains Finisar 850nm SFF transceivers that are Class I laser products and 
comply with Laser Safety requirements per FDA/CDRH and IEC-825-1 regulations. Agilent 
Technologies, Inc. uses these products in compliance with FDA Laser Notice 42. The Finisar 
transceivers are certified per the following standards: 

 
Finisar Transceiver Safety Specifications 

 
 

Feature 
 

Agency 
 

Standard 
 

Certificate Number 

Laser Eye Safety FDA/CDRH FDA 21(J) CFR 9210176-17 

Laser Eye Safety TÜV EN60950 

EN 60825-1 

EN 60825-2 

R9772230.07 

Electrical Safety UL/CSA CLASS 3862.07 

CLASS 3862.87 

CSA 1034405 
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Safety Symbols and Instrument Markings 
 

Symbols and markings in manuals and on instruments alert you to potential risks, provide 
information about conditions, and comply with international regulations. The following table 
defines the symbols and markings you may find in a manual or on an instrument. 

 
Safety symbols and instrument markings 

 

Safety symbols 
 
 

Warning: risk of electric shock. 
 

 
 

Caution: refer to accompanying documents. 
 

 
 

Alternating current. 

Earth (ground) terminal 

 

 
Protective earth (ground) terminal 

 

 
 

Frame or chassis terminal 
 
 

Terminal is at earth potential. Used for measurement and control circuits 

designed to be operated with one terminal at earth potential. 
 

Instrument markings 
 

The CE mark is a registered trademark of the European Community. 

If it is accompanied by a year, it indicates the year the design was 

proven. 

 
N10149 

 

The C-tick mark is a registered trademark of the Spectrum 

Management Agency of Australia. This signifies compliance with 

the Australian EMC Framework regulations under the terms of the 

Radio Communications Act of 1992. 
 

ISM1-A This text indicates that the instrument is an Industrial Scientific and 

Medical Group 1 Class A product. 
 

This product complies with the WEEE Directive (2002/96/EC) 

marking requirements. The affixed label indicates that you must not 

discard this electrical/electronic product in domestic household 

waste.1 

 
1The URL for take-back/WEEE information is http://www.agilent.com/environ- 
ment/product 

http://www.agilent.com/environ-
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Service and Support 
 

Any adjustment, maintenance, or repair of this product must be performed by qualified personnel. 
Contact your customer engineer through your local Agilent Technologies Service Center. 

 
Agilent on the Web You can find information about technical and professional services, product support, and 

equipment repair and service on the Web at: 

http://www.agilent.com/ 
 

1. Click the Select a Country or Area link (upper-right corner of the page) and select your 
country. When you click "Submit" it returns to the Agilent home. 

 

2. Hover over the Products and Services tab. 
 

3. Select the Repair and Calibration Services link. 
 

Agilent by Phone Or you can call one of the numbers in the following table. 
 

Agilent Call Centers and Regional Headquarters 
 

United States and Canada: Test and Measurement Call Center 

(800) 452 4844 (toll-free in US) 

Europe: (41 22) 780 8111 

Japan: Measurement Assistance Center 

(81) 0426 56 7832 

Latin America: 305 269 7548 

Asia-Pacific: (85 22) 599 7777 

http://www.agilent.com/
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*openScreenTime: 5 
*useHardware: True 
*newEnergyLogViewLength: 1000 
*handoffLogViewLength: 500 
*alarmLogViewLength: 100 

 

 
 
 
 
 
  
 

Appendix A: d.E3238s Listing 
 

The following file listing is from the d.E3238s Motif resource file in the c:\e3238s  home direc- 

tory. Do not modify this file. To modify or add resource parameters, copy it to the name E3238s 

and modify that file. 
 

!! $Revision: 1.14 $ 

!! 
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 
!! Application Resources !! 
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 

 
 
 

*spectrogramBackingStoreSize: 2000000 

*dataBufferSize: 8000000 
*maxEnergyHistorySize: 5000 
*signalDatabaseSize: 500000 
*sr71Enabled: False 
*enhancedSpectrogramMarker: True 
*maxSpectrogramColors: 32 
*displayLocalTime: True 
*maxHandoffRxs: 16 
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Appendix B: d.e3238s.cfg Listing 
 

When the E3238S program starts, the system looks for a file named e3238s.cfg. If the 

location of the file is not specifically defined in the resource file (see Application Resources), 

the configuration file in the e3238s directory is used. 
 

The file installed initially is d.e3238s.cfg in the e3238s directory. If no file exists named 

e3238s.cfg, a duplicate of d.e3238s.cfg is created and given that name. 
 

When you upgrade (i.e., install the E3238S software on a system with an earlier version) the 

installation process does not overwrite the existing e3238s.cfg file. This avoids destroy- 

ing configuration information you may need. You may need to edit the file and incorporate 

new commands from the d.e3238s.cfg file before the upgrade will perform properly. 
 

The commands in this file are documented in the chapter titled “Hardware Configuration 

Reference”. The following is a listing of the d.e3238s.cfg file. 

 

 
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 

!  E3238s Hardware Configuration Resource File    $Revision: 1.8 $     ! 

!                                                                      ! 

!  For the N6841A RF Sensor                                            ! 

!                                                                      ! 

!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 

!  

! This file is initially installed in the E3238s system   

!   as d.e3238s.n6841.cfg in the C:\E3238s\N684x_RF_Sensor directory.   

! 

! This file is used to tell the software what type of hardware to  

!   configure into the system.  The file configures the system at  

!   startup. 

! 

! Lines starting with "!" are comments.  

! 

! Depending on OS used (WinXP or Win7), the location of certain files may 

!   either be in 'program files' (WinXP) or 'program files (x86)' (Win7). 

! Both versions are included in the lines below, with the Win7 version  

!   uncommented. 

!  

! For more information, see the Hardware Configuration chapter  

!   of the E3238S Installation and Configuration Reference 

! 

! 

!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 

!                 Hardware Platform                                    ! 

!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 

! 

! The platform configuration commands are as follows: 

! 

!   platform:              [N6841] 

!     Specifies the hardware platform type (RF Sensor only). 

! 

!   platformCfg:  <numSensors>, <address>, ..., <useTcp>, <driverDll> 

!     Specifies the driver software and sensor addresses 

!       <numSensors>     [1 to 4] Number of RF sensor nodes. 

!       <address>        IP address or hostname or ?. 

!       <useTcp>         (Optional) 0 = fast UDP data link, 1= TCP/IP. 

!       <driverDll>      (Optional) DLL file. 

! 

!     Note: Use "?" for <address> to prompt for address at startup.  
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platform:      N6841 

 

! Single-sensor platform configuration: 

platformCfg:   1, ?, 1, C:\program files (x86)\agilent\rfsensor\bin\n6841Driver.dll 

!platformCfg:   1, ?, 1, C:\program files\agilent\rfsensor\bin\n6841Driver.dll 

 

! Un-comment one of the following (and comment-out the above line) if you need to  

! control more than one RF Sensor from a single instance of the E3238S software. 

 

! Two-sensor platform configuration: 

!platformCfg:   2, ?, ?, 1, C:\program files (x86)\agilent\rfsensor\bin\n6841Driver.dll 

!platformCfg:   2, ?, ?, 1, C:\program files\agilent\rfsensor\bin\n6841Driver.dll 

 

! Three-sensor platform configuration: 

!platformCfg:   3, ?, ?, ?, 1, C:\program files 

(x86)\agilent\rfsensor\bin\n6841Driver.dll 

!platformCfg:   3, ?, ?, ?, 1, C:\program files\agilent\rfsensor\bin\n6841Driver.dll 

 

! Four-sensor platform configuration: 

!platformCfg:   4, ?, ?, ?, ?, 1, C:\program files 

(x86)\agilent\rfsensor\bin\n6841Driver.dll 

!platformCfg:   4, ?, ?, ?, ?, 1, C:\program files\agilent\rfsensor\bin\n6841Driver.dll 

 

!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 

!                 Search Receiver DSP Configuration                    ! 

!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 

! 

! No DSP configuration is specified for the N6841A   

 

searchRx1.dspModel:   None 

 

!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 

!                   User Programming Shared Libraries                  ! 

!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 

! 

! The libraries for each of the user-defined feature sets are loaded with 

! the following commands. 

! (Currently incl. Survey, Menu Arrows, USD and N6854A Geo) 

 

genericLib:            C:/e3238s/usd/usdHost.dll -allownb, c:/e3238s/lib/survey.dll 

userMenu:              C:/e3238s/usd/usdHost.dll, c:/e3238s/lib/survey.dll, 

C:/e3238s/lib/userMenuArrow.dll 

featureExtraction:     C:/e3238s/usd/usdHost.dll, c:/e3238s/lib/survey.dll 

energyHistoryFilter:   C:/e3238s/usd/usdHost.dll, C:/e3238s/lib/survey.dll               

userPane:              C:\program files (x86)\agilent\rfsensor\bin\n6841DriverExtra.dll  

!userPane:              C:\program files\agilent\rfsensor\bin\n6841DriverExtra.dll  

userAlarmTask:         C:\program files (x86)\agilent\rfsensor\bin\n6841DriverExtra.dll 

!userAlarmTask:         C:\program files\agilent\rfsensor\bin\n6841DriverExtra.dll 

userThreshold: 

 

!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 

!                    Modulation Recognition                            ! 

!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 

! 

! Remove or comment out these lines if option MR1 is not available. 

 

modRec1.enabled:    True 

modRec1.hostLib:    c:/e3238s/MR1/mr1.dll 

modRec1.args: 

modRec1.alias: 

 

 

exportLib: c:/e3238s/e3238sDB/e3238sDB.dll connect_timeout=5 
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!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 

!                   Socket Server Configuration                        ! 

!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 

! 

! The E3238S provides communication to the external world via sockets. 

! To enable the socket interface on the workstation you must create a port 

! number and enable the E3238S socket commands.  To create the port number 

! enter a line in the C:\WINNT\system32\drivers\etc\services file as follows: 

!          e3238s    7011/tcp 

! 

! The socket configuration is defined with the following commands: 

! 

! 

! Parameter/command           Range                   Default value 

! ------------------          ------------            -------------- 

! socketServer:               {Disabled or Enabled}   Disabled 

! maxServices:                <1 to 5>                1 

! maxClientSockets:           <0 to 16>               0 

! socketServerTimerInterval:  {1 to 10000 mSec}       5 

 

socketServer:                Enabled 

maxServices:                 5 

maxClientSockets:            5 

socketServerTimerInterval:   5 

 

!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 

!                  E3238s Service Configuration                        ! 

!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 

! 

! The E3238s service is defined with the following commands: 

! 

! Parameter/command            Range                   Default value 

! ------------------           ------------            -------------- 

! e3238sService:               {80 character string}   e3238s 

! e3238sServiceMaxConnections: {1 to 32}               4 

! e3238sServiceDataBufferSize: {512 to 4194304}        512 

! e3238sServiceSendBufferSize: {0 to 8388608}          0 (Use system default) 

! e3238sServiceRecvBufferSize: {0 to 8388608}          0 (Use system default) 

 

e3238sService:                 e3238s 

e3238sServiceMaxConnections:   4 

e3238sServiceDataBufferSize:   512 

e3238sServiceSendBufferSize:   0 

e3238sServiceRecvBufferSize:   0 

 

!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 

!                  Handoff Receiver Configuration                      ! 

!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 

! 

! The following handoff receivers are supported in this software: 

! 

!   None 

!   Agilent N6841A RF sensor 

!   ICOM R20 

!   ICOM R8500 

!   ICOM PCR1000 

!   WiNRADiO G303, G305, G313, G315 

!   WJ-8607 

!   WJ-8611 

!   WJ-8615P 

!   Cubic R-2412/U 

!   Software * 

! 

!   *Note: The software receiver receives handoffs and simulates a real 
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!   handoff receiver.  No software detection or processing is done. 

! 

! The following analyzers are supported in this software: 

! 

!   Agilent 89441A 

!   Agilent 89600 

! 

! Each handoff receiver is described with three lines in this file: 

! 

!   handoffRx<N>.driver:      C:\e3238s\lib\<driver shared library> 

!   handoffRx<N>.interface:   <interface>,<interface parameters> 

!   handoffRx<N>.label:       <label> 

! 

! where  

!   <N> is the number of the handoff receiver that appears on the 

!       e3238s user interface (e.g. 1), may be as large as 100. 

!   <driver shared library> is the filename of the handoff receiver  

!       shared library (e.g. C:\e3238s\lib\HD_8711.dll) # 

!   <interface>,<interface parameters> identifies the hardware interface  

!       to the receiver and parameters of the interface  

!       (e.g rs232,ASRL0,9600) 

!   <label> is the label which appears in the handoff receiver pane, 

!       and can be up to 31 characters in length. 

! 

!   #Note: The shared library for the N6841A is located in the 

!   agilent\rfsensor\bin folder 

! 

! Uncomment the lines for any handoff receiver you have available and 

!   connected to enable control from the E3238S software. 

! 

! Examples for each supported handoff receiver are present further down  

!   in this file. 

 

!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 

!!! Agilent RF Sensor       !!! 

!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 

! 

! The Agilent RF Sensor software must be installed to use this driver. 

! 

! This enables control of the "same" RF Sensor as a handoff receiver. 

! The caveat is that the hostname and sensor name have to be the same and 

! you have to use the hostname to connect from the E3238S (not IP address). 

  

handoffRx1.driver:      C:\program files (x86)\agilent\rfsensor\bin\n6841DriverExtra.dll  

!handoffRx1.driver:      C:\program files\agilent\rfsensor\bin\n6841DriverExtra.dll   

handoffRx1.interface:    

handoffRx1.label:       HORx1 

 

! These lines enable control of a second RF Sensor as a handoff receiver.  

 

handoffRx2.driver:      C:\Program Files (x86)\Agilent\RFSensor\bin\n6841DriverExtra.dll 

!handoffRx2.driver:      C:\Program Files\Agilent\RFSensor\bin\n6841DriverExtra.dll 

handoffRx2.interface:   

handoffRx2.label:       HORx2 

 

!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 

!!!      ICOM PCR1000       !!! 

!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 

! 

! handoffRxN.driver:    c:\e3238s\lib\HD_IcomPcr1000.dll 

! handoffRxN.interface: rs232,ASRL<N>,9600,0 

!                          |      |     |  | 

!                          |      |     |  +-- non-zero for debug output 

!                          |      |     +--- baud rate (must be 9600) 
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!                          |      +-- ASLR1 or ASRL2 (VISA names for COM1..) 

!                          +-- must be rs232 

 

!handoffRx1.driver:    C:\e3238s\lib\HD_IcomPcr1000.dll 

!handoffRx1.interface: rs232,ASRL8,9600,0 

!handoffRx1.label:     ICOM PCR-1000 Rx 

 

!!!!!!!!!!!!!!!!!!!!!! 

!!! WiNRADiO       !!! 

!!!!!!!!!!!!!!!!!!!!!! 

! 

! "interface" should be "application,<SN>" 

! where <SN> is optional. Use it to select from multiple receivers.  

! Start the WiNRADiO windows application before starting E3238S. 

                                  

!handoffRx1.driver:    C:\e3238s\lib\HD_WinRadio.dll 

!handoffRx1.interface: application 

!handoffRx1.label:     WiNRADiO Rx 

 

!!!!!!!!!!!!!!!!!!!!!! 

!!! ICOM R20       !!! 

!!!!!!!!!!!!!!!!!!!!!! 

! 

! handoffRxN.driver:    c:\e3238s\lib\HD_icom_r20.dll 

! handoffRxN.interface: rs232,ASRL<N>,1200,4a,0 

!                          |      |     |  |  | 

!                          |      |     |  |  +-- non-zero for debug output 

!                          |      |     |  +-- radio address in hex 

!                          |      |     +-- baud rate 

!                          |      +-- ASLR1 or ASRL2 (VISA names for COM1..) 

!                          +-- must be rs232 

 

!handoffRx1.driver:    c:\e3238s\lib\HD_icom_r20.dll 

!handoffRx1.interface: rs232,ASRL2,9600,6c,0 

!handoffRx1.label:     VHF/UHF RCVR 

 

!!!!!!!!!!!!!!!!!!!!!! 

!!! ICOM R7000     !!! 

!!!!!!!!!!!!!!!!!!!!!! 

! 

! handoffRxN.driver:    c:\e3238s\lib\HD_icom_r7000.dll 

! handoffRxN.interface: rs232,ASRL<N>,1200,4a,0 

!                          |      |     |  |  | 

!                          |      |     |  |  +-- non-zero for debug output 

!                          |      |     |  +-- radio address in hex 

!                          |      |     +-- baud rate 

!                          |      +-- ASLR1 or ASRL2 (VISA names for COM1..) 

!                          +-- must be rs232 

 

!handoffRx1.driver:    c:\e3238s\lib\HD_icom_r7000.dll 

!handoffRx1.interface: rs232,ASRL2,9600,6c,0 

!handoffRx1.label:     VHF/UHF RCVR 

 

!!!!!!!!!!!!!!!!!!!!!! 

!!! ICOM PCR1000   !!! 

!!!!!!!!!!!!!!!!!!!!!! 

! 

! handoffRxN.driver:    c:\e3238s\lib\HD_IcomPcr1000.dll 

! handoffRxN.interface: rs232,ASRL<N>,9600,0 

!                          |      |     |  | 

!                          |      |     |  +-- non-zero for debug output 

!                          |      |     +-- baud rate (must be 9600) 

!                          |      +-- ASLR1 or ASRL2 (VISA names for COM1..) 

!                          +-- must be rs232 
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!handoffRx1.driver:    c:\e3238s\lib\HD_IcomPcr1000.dll 

!handoffRx1.interface: rs232,ASRL2,9600,0 

!handoffRx1.label:     VHF/UHF RCVR 

 

!!!!!!!!!!!!!!!!!!!!!! 

!!! ICOM R8500     !!! 

!!!!!!!!!!!!!!!!!!!!!! 

! 

! handoffRxN.driver:    c:\e3238s\lib\HD_icom_r8500.dll 

! handoffRxN.interface: rs232,ASRL<N>,1200,4a,0 

!                          |      |     |  |  | 

!                          |      |     |  |  +-- non-zero for debug output 

!                          |      |     |  +-- radio address in hex 

!                          |      |     +-- baud rate 

!                          |      +-- ASLR1 or ASRL2 (VISA names for COM1..) 

!                          +-- must be rs232 

 

!handoffRx1.driver:    c:\e3238s\lib\HD_icom_r8500.dll 

!handoffRx1.interface: rs232,ASRL2,9600,6c,0 

!handoffRx1.label:     VHF/UHF RCVR 

 

!!!!!!!!!!!!!!!!!!!!!! 

!!! WJ-8607        !!! 

!!!!!!!!!!!!!!!!!!!!!! 

 

!handoffRx1.driver:    C:\e3238s\lib\HD_8607.dll 

!handoffRx1.interface: rs232,ASRL0,9600 

!handoffRx1.label:     VHF/UHF  Rx 

 

!!!!!!!!!!!!!!!!!!!!!! 

!!! WJ-8611        !!! 

!!!!!!!!!!!!!!!!!!!!!! 

 

!handoffRx1.driver:    C:\e3238s\lib\HD_8611.dll 

!handoffRx1.interface: rs232,ASRL0,9600 

!handoffRx1.label:     VHF/UHF  Rx 

 

!!!!!!!!!!!!!!!!!!!!!! 

!!! WJ-8615P       !!! 

!!!!!!!!!!!!!!!!!!!!!! 

 

!handoffRx1.driver:    C:\e3238s\lib\HD_8615P.dll 

!handoffRx1.interface: gpib,hpib,5 

!handoffRx1.label:     VHF/UHF  Rx 

 

!!!!!!!!!!!!!!!!!!!!!! 

!!! Cubic R-2412/U !!! 

!!!!!!!!!!!!!!!!!!!!!! 

 

!handoffRx1.driver:    C:\e3238s\lib\HD_2412.dll 

!handoffRx1.interface: gpib,hpib,5 

!handoffRx1.label:     VHF/UHF RCVR 

 

!!!!!!!!!!!!!!!!!!!!!! 

!!! Software       !!! 

!!!!!!!!!!!!!!!!!!!!!! 

! 

! This is used for demonstration purposes only. 

 

!handoffRx1.driver:    C:\e3238s\lib\HD_software.dll 

!handoffRx1.label:     Software Rx 

 

!!!!!!!!!!!!!!!!!!!!!! 
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!!! Agilent 89441A !!! 

!!!!!!!!!!!!!!!!!!!!!! 

 

!handoffRx1.driver:    C:\e3238s\lib\HD_89441.dll 

!handoffRx1.interface: telnet,11.22.33.44 

!handoffRx1.interface: gpib,hpib,19 

!handoffRx1.label:     Signal Analyzer 

 

!!!!!!!!!!!!!!!!!!!!!! 

!!! Agilent 89600  !!! 

!!!!!!!!!!!!!!!!!!!!!! 

! 

! See C:\e3238s\89600\Readme.txt for instructions 

 

!handoffRx1.driver:    C:\e3238s\lib\hd_89600.dll 

!handoffRx1.interface: hostname, 7016 

!handoffRx1.label:     Signal Analyzer 

 

!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 

!                   Menu Access Configuration                          ! 

!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 

! 

! You can disable access to any of the features that are listed in the  

! main menus (those that appear in the menu bar).  Using the 'disableAccess' 

! command in this configuration file sets the initial status to disabled. 

! Access to these features can be enabled while the application is running 

! from the File, Access Control ... dialog box.  This is password protected 

! if the user name "e3238s" appears in the password file.  If no such entry 

! exists, there are no restrictions on menus access that a user can't change. 

! 

! To disable a particular menu, use the 'disableAccess' command with an 

! argument that is a string that exactly matches the feature label.  You can 

! also check the Access Control dialog box for the button label strings. 

! Any feature not specifically disabled is, by default, enabled at startup. 

 

!disableAccess: Secure Display 

!disableAccess: Log Files ... 

!disableAccess: Clear Log 

!disableAccess: Clear Log File 

!disableAccess: Clear Energy History 

!disableAccess: Clear Signal Database 

!disableAccess: Clear Frequency Lists 

!disableAccess: Clear Audio Output 

!disableAccess: Clear All 

 

!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 

!                  Other Configuration settings                        ! 

!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 

! Other configuration command lines can be added here. For command  

! examples see the file d.e3238s.cfg typically installed to C:\e3238s. 
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